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General Safety Summary

General Safety Summary
Review the following safety precautions to avoid injury and prevent damage to this product or any
products connected to it.

To avoid potential hazards, use this product only as specified.

Only qualified personnel should perform service procedures.

While using this product, you may need to access other parts of a larger system. Read the safety sections
of the other component manuals for warnings and cautions related to operating the system.

To Avoid Fire or Personal Injury
Connect and Disconnect Properly. Connect the probe output to the measurement instrument before
connecting the probe to the circuit under test. Connect the probe reference lead to the circuit under test
before connecting the probe input. Disconnect the probe input and the probe reference lead from the circuit
under test before disconnecting the probe from the measurement instrument.

Observe All Terminal Ratings. To avoid fire or shock hazard, observe all ratings and markings on the product.
Consult the product manual for further ratings information before making connections to the product.

Do Not Operate Without Covers. Do not operate this product with covers or panels removed.

Do Not Operate With Suspected Failures. If you suspect that there is damage to this product, have it
inspected by qualified service personnel.

Avoid Exposed Circuitry. Do not touch exposed connections and components when power is present.

Terms in this Manual
These terms may appear in this manual:

WARNING. Warning statements identify conditions or practices that could result in injury or loss of life.

CAUTION. Caution statements identify conditions or practices that could result in damage to this product or other
property.
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Introduction

Using Online Help
Select Help from the menu to open the help file. You can also find an electronic copy of the help file in the
Documents directory on the 063-4068-XX DVD.

Tables of Contents (TOC) tab—Organizes the Help into book-like sections. Select a book icon to open
a section; select any of the topics listed under the book.

Index tab— Enables you to scroll a list of alphabetical keywords. Select the topic of interest to bring
up the appropriate help page.

Search tab— Allows a text-based search.

Follow these steps:

1. Type the word or phrase you want to find in the search box. If the word or phrase is not found, try the
Index tab.

2. Choose a topic in the lower box, and then select the Display button.

General Help Functions:
Select the Print button from the Help topics menu bar to print a topic.

To return to the previous window, select the Back button.

Use hyperlinks to jump from one topic to another.

If the back button is grayed out or a jump is not available, choose the Help Topics button to return to
the originating help folder.

TekExpress™ Serial ATA Automated Compliance Solutions 1



Introduction Related Documentation

Related Documentation
In addition to this TekExpress Online Help, the following documentation is included with the software:

TekExpress Installation Manual, Tektronix part number 071-2268-XX. The Installation Manual has
information about installing and upgrading the software.

TekExpress Quick Start User Manual, Tektronix part number 071-2298-XX. The Quick Start User
Manual has information about how to use the software and includes application examples.

Technical Specification documents
http://www.tek.com/Measurement/applications/serial_data/sata.html

Conventions
Online Help uses the following conventions:

The term “SATA” refers to Serial Advanced Technology Attachment.

The term “DUT” is an abbreviation for Device Under Test.

The term “select” is a generic term that applies to the two mechanical methods of choosing an option:
using a mouse or using the touch screen.

Table 1: Icon descriptions
Icon Meaning

This icon identifies important information.

This icon identifies conditions or practices that could result in loss of data.

This icon identifies additional information that will help you use the
application more efficiently.
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Technical Support
Tektronix values your feedback on our products. To help us serve you better, please send us your
suggestions, ideas, or comments on your application or oscilloscope.

When you contact Tektronix Technical Support, please include the following information (be as specific as
possible):

General Information
All instrument model numbers.

Hardware options, if any.

Probes used.

Your name, company, mailing address, phone number, FAX number.

Please indicate if you would like to be contacted by Tektronix about your suggestion or comments.

Application Specific Information
Software version number.

Description of the problem such that technical support can duplicate the problem.

If possible, save the setup files for all the instruments used and the application.

If possible, save the TekExpress setup files, log.xml and status messages text file.

If possible, save the waveform on which you are performing the measurement as a .wfm file.

Forward the information to technical support using one of these methods:

E-mail – techsupport@tektronix.com

FAX – (503) 627-5695
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Getting Started

What is new in this release
This version of TekExpress Serial ATA includes the following feature enhancements:

The Programmatic interface which allows you to seamlessly integrate the TekExpress Test Automation
application with the high-level automation layer.

The PHY-TSG-OOB test suite is included for Serial ATA Gen1 and Gen2 test coverage which offers
compliance test automation solution for PHY General requirements (PHY: 1-4), PHY Transmitted
Signal Group Requirements (TSG: 1-12), PHY OOB Requirements (OOB: 1-7) using a Tektronix
Real Time DSO.

The RX-TX test suite is included for Serial ATA Gen1 and Gen2 test coverage which offers compliance
test automation solution for PHY Transmit (TX: 1-6) and PHY Receive (RX: 1-6) channel test
requirements using Tektronix sampling oscilloscope.

The SI test suite is included for SATA electrical cable assembly compliance testing using a sampling
oscilloscope with IConnect-S-parameter and impedance profile computational software.

This release also includes RSG-RMT test suite for Serial ATA Gen1 and Gen2 test coverage which offers
Phy Receiver Signal Group Requirements (RSG 1-2) and Receiver Margin Test (RMT) which were
part of earlier version of TekExpress Serial ATA.
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Accessories

About the Test Fixture
The TF-SATA-NE-ZP and TF-SATA-FE-ZP test fixtures that facilitate SATA Compliance testing are
manufactured and distributed by Crescent Heart Software, Inc. For more information, visit the Crescent
Heart Software Web site www.c-h-s.com.

About Frame Error Analyzer
The Crescent Heart Software SATA II probe adapter facilitates Receiver Signalling Group test. Visit
www.c-h-s.com for more information.

About Keithley Switch
The S46 Microwave Switch System is designed to simplify the automated switching needed
to test a wide range of telecommunications products and devices. For more information, visit
http://www.keithley.com/applications/aerospace/?mn=S46.
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Minimum System Requirements
The minimum system requirements for a PC to run TekExpress are as follows:

Table 2: System requirements
Processor Pentium 4/M or equivalent processor.
Operating System Windows XP Service Pack 2.
Memory 512 MB of memory.
Hard Disk Approximately 2 GB of available hard-disk space for the recommended

installation, which includes full TekExpress installation and distributed
components.

Drive DVD drive
Display Super VGA resolution or higher video adapter (800x600 minimum video

resolution for small fonts or 1024x768 minimum video resolution for large fonts).
The application is best viewed in 96 dpi display settings 1.

Software IConnect S-parameter software (80SSPAR) and JIT3 3.0x.

Microsoft Excel 2002 or above.

Microsoft Internet Explorer 6.0 SP1 or later.

Microsoft Photo Editor 3.0 or equivalent software for image files viewing.

Adobe Reader 6.0 or equivalent software for viewing portable document
format (PDF) files.

Other Devices Microsoft compatible mouse or compatible pointing device.

Four USB ports (2 USB ports minimum).

PCI-GPIB or equivalent interface for instrument connectivity 2.
1 If TekExpress is running on an instrument having a video resolution lower than 800x600 (for example, sampling oscilloscope), it is recommended

to connect a secondary monitor and this has to be enabled before launching the application.
2 If TekExpress is installed on a Tektronix oscilloscope, the virtual GPIB port can-

not be used by TekExpress for communicating with oscilloscope applications.
If external devices like USB-GPIB or equivalent are used for instrument connectivity, then ensure that the Talker
Listener utility is enabled in DPO/DSA oscilloscope’s GPIB menu.

TekExpress™ Serial ATA Automated Compliance Solutions 7



Getting Started Application Directories and Usage

Application Directories and Usage
Related Topics

File Name Extensions
How To Activate the License
View Test Related Files

The application directory and associated files are organized as follows:

The following table lists the default directory names and their usage:

Table 3: Default directory names and their usage
Directory names Usage
InstallDir\TekExpress Contains the application and associated files.
\TekExpress\Compliance Suites Has compliance specific sequence files. The folders

under this directory represent the devices to be
tested.

\TekExpress\Compliance Suites\Serial ATA\ The folders under this are Cable, Drive and Host.
\TekExpress\Compliance Suites\Serial ATA\Cable Includes the SI folder. This represents the suite of

install tests for SATA cables.
\TekExpress\Compliance Suites\Serial ATA\Drive\
\TekExpress\Compliance Suites\Serial ATA\Host\

Includes the PHY-TSG-OOB, RSG-RMT, and
RX-TX folders. These represent the suites of install
tests for the SATA drive and host devices.
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Table 3: Default directory names and their usage (cont.)

Directory names Usage
\TekExpress\ACP
\TekExpress\SCP
\TekExpress\ICP

Includes instrument and application specific
interface libraries of TekExpress.

\TekExpress\Data Manager
\TekExpress\Data Storage
\TekExpress\Report Generator

Includes the result management specific libraries of
TekExpress are present in these folders.

\TekExpress\Documents Includes the Method of Implementation documents
and technical documentation for the application.

\TekExpress\Bin
\TekExpress\Lib
\TekExpress\Tools

Includes the Miscellaneous libraries of TekExpress.

File Name Extensions
Related Topics

Application Directories and Usage
How To Activate the License

The software uses the following file name extensions:

File name extension Description
.TekX The session file will be saved in this format.
.seq The test sequence file.
.xml The encrypted XML file that contains the test specific

configuration information. The log file extension is also xml.
.PDF The PDF file that details the method of implementation for

the test.
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How To Activate the License
Related Topics

Application Directories and Usage
File Name Extensions

Follow the steps below to activate the license:

1. Click Help > About to view the license information.

2. Click the View Version Details link to check the version numbers of the installed test suites.

3. Click the View End-User License Agreement link to open the following Tektronix Software License
Agreement window. Click Print to print the License Agreement.
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4. Click License Info to view the available software options. This window shows the license key and the
various options with their status (active or inactive) with the current license key.

5. If you are activating the license for the first time, the license key field will be empty. To activate
the license, connect the USB dongle to your computer, enter the license key provided in the license
key certificate, and click Activate. If the activation is successful, a sign is displayed next to
the license key field.

6. If you are reactivating the license, click Reactivate, enter the new license key and click Activate.
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Before You Click Run
After you first launch TekExpress, it creates the following folders on your computer:

\My Documents\My TekExpress

NOTE. Ensure that the “My TekExpress” folder has read and write access.

NOTE. If a user with a different Windows login ID launches TekExpress, a new My TekExpress folder is created
under that user’s My Documents folder

\My Documents\My TekExpress\Serial ATA

\My Documents\My TekExpress\Serial ATA\Untitled Session. Every time the
TekExpress SATA.exe is launched a Untitled Session folder is created under Serial ATA

folder. The Untitled Session folder is deleted when you exit TekExpress.

WARNING. Each session has multiple files associated with it. Do not modify any of the session files and/or folders as
this may result in loss of data or corrupted session files.

The My TekExpress folder is created as a shared folder with share name as <domain><user
ID> My TekExpress (or if the PC is not connected to domain then share name is <Computer
name><user ID> My TekExpress).

The above shared folder is mapped as X: (X drive) on to the PC where TekExpress is running.

NOTE. If X drive is mapped to any other shared folder, TekExpress will pop-up a Warning message window asking to
disconnect the X: drive manually.

Do the following before you click Run:

NOTE. Ensure that the network connectivity is enabled on the PC running the TekExpress.

1. Map the shared My TekExpress folder as X: (X drive) on all the instruments used in test setup
running Microsoft Windows Operating System. This share folder is used to save the waveform files
or any other file transfer operations.

2. Right click on the My TekExpress folder and open the Properties dialog box. Select General tab
and then Advanced. In the Advanced Attributes window, ensure that the option Encrypt contents
to secure data is NOT selected. Click here to view the picture.
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3. Ensure that the SATA setup files provided with TekExpress DVD are available on the respective
instruments. For more details, refer to the ReadmeFirst.txt located in the SATA Setup Files

folder on theTekExpress DVD.

4. Ensure that all the required instruments are properly warmed up, Signal Path Compensation (SPC) is
perfomed, followed by cable deskew.

Mapping My TekExpress folder
To map the My TekExpress folder on the instruments, follow the steps below:

1. Open Windows Explorer.

2. From the Windows Explorer menu, select Tools > Map Network drive.

3. Select the Drive letter as X: (if there is any previous connection on X:, disconnect it first through
Tools > Disconnect Network drive menu of Windows Explorer).

4. In the Folder field, enter remote My TekExpress folder path (for example, \\192.158.97.65\
John’s My TekExpress)

5. You can determine the IP address of the PC where “My TekExpress” folder exists by doing the
following:

Select Start > Run menu on the PC where My TekExpress folder exists.

Enter cmd and click Enter.

At command prompt, type ipconfig.
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You can find SPC by following the steps below:

1. On the oscilloscope main menu, click Utilities menu.

2. Click Instrument Calibration option.
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Operating Basics

TekExpress Application Overview
TekExpress is the Tektronix Compliance Test Automation Framework, developed to support current and
future test automation needs of customers. Developed using National Instruments’ TestStand, TekExpress
leverages on the capabilities of Microsoft .NET framework. It is a highly modular architecture that enables
deploying automated test solutions for various serial standards in a relatively short time. TekExpress
provides a compliance test automation solution for the Serial ATA Gen 1 and Gen 2 standard.

Options available with TekExpress Serial ATA are:

PHY/TSG/OOB Test Suite – The PHY-TSG-OOB test suite is included for Serial ATA Gen1 and
Gen2 test.

RSG-RMT Test Suite – Offers Phy Receiver Signal Requirements (RSG 1-2) and Receiver Margin
Test (RMT).

Rx-Tx Test Suite – The RX-TX test suite is included for Serial ATA Gen1 and Gen2 test.

TekExpress SATA Bundle for the Host and Drive Test Suites.

SI Cable Tests for TekExpress SATA – The SI test suite is included for SATA electrical cable assembly
compliance test.

Key Features
The TekExpress provides the following salient features:

Complete SATA Gen1 and Gen2 Test Coverage for Hosts, Drives and Cables.

Completely automated single button solution.

Significant Reduction In Testing Time Through Automation.

Performs all (UTD 1.2 conformant) SATA MOI required Transmitter, Receiver and Channel
measurements.

Single & Simple Microsoft Windows XP User Interface for Multi-instrument Testing.

Repeatable and Accurate Results.

Automatic HTML Report and SATA-IO (MS Excel) Scorecard Generation.

Receiver Margin Testing.

Direct Synthesis and Device State Control Eliminates the Need for Multiple Sources.

Powered by NI TestStand™.

Seamlessly Integrate with High-level TestStand Automation Layer.
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Starting the Application
Related Topics

Resizing the Application Window
Exiting the Application

The application uses a USB dongle that contains the license key. This dongle must be present on the PC or
the instrument hosting the TekExpress application.

The application also checks for a file, called Resources.xml, located in My TekExpress folder. If this file
is not found, instrument discovery is performed before launching TekExpress. The Resources.xml file
contains information regarding instruments available on network.

When the application starts, it checks for the appropriate license key. If the valid license key is not present,
the application switches to the “Demo” mode. If the application fails to detect the dongle, it continues
to run in Demo mode.

To start the application, you can do one of the following:

Click Start > Programs > Tektronix > TekExpress > TekExpress SATA. Other applications follow
similar pattern.

Double click the icon on the desktop.

If you have previously saved a session, you can double-click the session file stored under My
TekExpress\Serial ATA.

When the application is launched it displays the splash screen providing launch information. The
application also checks for the presence and validity of the USB dongle.

NOTE. If the application was not terminated properly during the last use, a dialog box asks to recall the previously
unsaved session.
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Resizing the Application Window
Related Topics

Starting the Application
Exiting the Application

To minimize the application, click on the application title bar. To restore the application to its

previous size, select in the Windows task bar.

To maximize the application, click . To restore it to previous size, click on the application
title bar.

Exiting the Application
Related Topics

Starting the Application
Resizing the Application Window

To exit the application, do one of the following:

Click File > Exit.

Click on the application title bar.

TekExpress™ Serial ATA Automated Compliance Solutions 17



Operating Basics Global Controls

Global Controls
The menus and controls that appear outside the individual tabs are called “Global Controls”. These are
used to specify the devices to be tested.

Table 4: Controls and Functions
Control name Function
DUT The device ID is specified at the global level and the

information is stored in the default location for all data
files. This field cannot be empty and does not allow these
special characters (.,..,...,\,/:?”<>|*). The maximum length
of characters allowed is 32.
You will be able to run/stop the tests.

Menus
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File Menu
Related Topics

View Menu
Tools Menu
Help Menu

Click File on the application menu bar.

The File menu has the following selections:

Menu Function
New Session Starts a default session of TekExpress.
Open Session Opens a saved session.
Save Session Saves the session.
Save Session As Saves a session in a different name.
Save Report As Saves the report in user specified location.
Print Preview Report Previews the report before printing.
Print Report Opens the Windows “Print” dialog box.
Recent Sessions Lists recent sessions.
Exit Closes the application.
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View Menu
Related Topics

File Menu
Tools Menu
Help Menu

Click View on the application menu bar.

The View menu has the following selections:

Menu Function
Log File Opens the log (log.xml) file in the default viewer.
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Tools Menu
Related Topics

File Menu
View Menu
Help Menu
Deskewing Real Time Oscilloscopes

Click Tools on the application menu bar.

The Tools menu has the following selections:

Menu Function
Instrument Bench Opens a dialog box showing the list of instruments attached to the test setup.
Debug – Deskew Utility Opens a control panel that allows to control the RF-switch for debugging and

cable deskew.

Tools > Instrument Bench
The Instrument Bench window shows the list of VISA and Non-VISA resources found on different
interfaces/connections. It serves two purposes at the launch of TekExpress:

Discovers the connected instruments.

Confirms the instrument connection setup.

When you click Tools > Instrument Bench, the following dialog box is displayed:
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Search Criteria: The various connections on which you can search. Non-VISA Resources are the
instruments that cannot be searched using TekVISA.

Retrieved Instruments: Displays the count and details of instruments that were discovered.

Last Updated: Displays the time when the last time search was performed.

TekVISA Refresh Timeout (Seconds): This time out specifies the maximum time that TekExpress
can wait for TekVISA update.

NOTE. TekExpress uses TekVISA for instrument search. Ensure that TekVISA is running on your system before
you refresh the instrument bench window.

Table 5: Retrieved Resources properties in the Instrument Bench window
Title Description
Connection Shows the type of connection with the instrument.
Resource Shows the name of the resource.
Serial Number Shows the serial number of the resource.
Options Shows the options available on the instrument. 1

Resource Address Shows IP Address/Port number of the resource.
1 The option column displays the options that fit in the field. To view complete options on the instrument, move the mouse cursor over the option.

Table 6: Button controls on Instrument Bench dialog box
Button Function
Refresh The application searches on the selected connection for resources. While

searching resources it shows the Instrument Bench discovery window. The
Discovery window shows the connection currently being scanned and the
percentage of task completed.

Close Closes the dialog box.

Tools > Debug-Deskew Utility
The debug-deskew utility allows you to control the RF-switch state for setup debug purpose with primary
objective to perform a real-time oscilloscope deskew operation for complex wiring path from the DUT
TX terminals to the oscilloscope channels through the RF-switch. Using this utility, you can set the
oscilloscope deskew values that will be retained by TekExpress SATA automation script thoughout
various testing suites.
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To ensure accurate results for two-channel measurements and differential signals acquired on two
channels, it is important to first deskew the oscilloscope channels before you take measurements of
your DUT.

The Debug Deskew Utility has the following functions:

Apply RF Switch State: Sets the Open/Close state of the RF switch channels.

As per the setup requirement, select the channels on the panel to be closed or opened. The previous
state of the RF switch will be overridden by the new state. The current state of the RF Switch is not

recalled when the Debug panel is launched. Click and the current state as seen on the
panel will be applied on the selected RF Switch. The selection shown by LEDs on the RF Switch
should be same as the selection shown on the panel.

Read Deskew/Attenuation Values: Reads the the current Deskew values of the real time oscilloscope.

With the selected switch state, you are expected to manually perform the deskew (by removing SMA
cable connection from TX terminals of CHS fixture at DUT and reconnecting them to Fast-edge output

of the oscilloscope). Once the deskew values are set on the oscilloscope, click . The
deskew values of all the four channels on the selected real time oscilloscope is read by TekExpress and
are retained during test automation sequencing.

Restore Deskew/Attenuation values. Click to restore the last values of
deskew/attenuation. It will be restored to the selected oscilloscope.

NOTE. The address of the instruments are passed to the panel on the current suite selection (as detected in
instrument discovery). For example, in RX-TX and SI test suites, the Real Time Oscilloscope is not available and so it
will not be passed. Only the address of the RF Switch is passed, if detected.
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For more information on how to deskew real time oscilloscopes, refer to the section Deskew operation.

Help Menu
Related Topics

File Menu
View Menu
Tools Menu

Click Help on the application menu bar.

The Help menu has the following selections:

Selection Description or Function
TekExpress Help Displays TekExpress Help (F1).
About.. Displays application details such as software name, version

number and copyright.
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How To

Select the Test(s)
Related Topics

View and Select Connected Instruments
Configure and Run the Tests
View the Progress of Analysis
View the Report
View Test Related Files

The application tests three types of SATA devices for compliance.

Cable

Drive

Host

The Select panel allows you to select tests to configure and run.
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This panel provides the following functions:

Select Device
Select the Device type. And the test suite options will be automatically updated corresponding to the
device selected.

Select Test Suite
The application allows you to select a subset of tests to execute. Based on the test suite selected, the
Version drop-down list will be populated.

Version
You can select the appropriate version. For example, SATA Gen 1 or SATA Gen 2.

NOTE. The SI test suite for cable measurement does not have any versions.

More/Less
The table has the following two columns:

Select: You can include or exclude any test for analysis.

Test Name: Displays the name of the test.

NOTE. If any of the check box in the Select column is grayed, you cannot make any changes. It implies that the
test is mandatory.

Once you select a row, the following options are available:

Table 7: Button controls on the Select panel
Button Description

Opens the configuration panel for the selected test.

Opens the PDF of method of implementation (MOI) for the selected test.

Opens the schematic for the selected test. This is useful if you want to
verify the test setup before running the test.

Selects all tests in the table.
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Table 7: Button controls on the Select panel (cont.)

Button Description
Selects all the SATA-IO required tests in the grid and deselects all
informative tests in the table.

Deselects all tests in the table.
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Configure and Run the Test(s)
Related Topics

Select the Tests

View and Select Connected Instruments

View the Progress of Analysis

View the Report

View Test Related Files

The configuration panel is used to create, view, and edit the parameters associated with the acquisition and
the analysis of the selected test.

You have the following options:

To choose between running the tests in a Compliance or User Defined mode.

To reload compliance mode values.

To change the parameters associated with the configuration of acquisition.

To change the parameters associated with analysis configuration.

The upper half of the Configure panel has general parameters that are common for all the tests under the
selected test suite that are editable. The lower half of the Configure panel has test specific parameters.

NOTE. If any of the test parameters are grayed, it means that these parameters cannot be modified in compliance
mode. When you switch to user-defined mode, these parameters are editable.
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Table 8: Test parameters
Parameters to configure Description
Acquire Parameters Shows the various parameters

related to acquisition of a selected
test. These parameters can vary
from one test to another such as,
Number of Samples and Record
Length.

Analyze parameters Shows the various parameters
related to analysis of a selected
test. These parameters can vary
from one test to another such as,
Jitter values.

Test Limits Applies to a specific test. It shows
the measurement limits using
different types of comparisons.
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Table 8: Test parameters (cont.)

Parameters to configure Description
Comments You can specify a comment up to

256 characters long for the selected
test.

Compliance settings
The compliance settings will be
restored.

Accepts all changes that you made.

Dismisses the dialog box and does
not apply changes.

Click Run in the Select panel to run the selected tests.

Refer to the following table for different test limit comparisons:

Table 9: Different test limit comparisons
Comparison string Description
EQ(==) Equal to
NE(!=) Not equal to
GT(>) Greater than
LT(<) Less than
GE(>=) Greater than or Equal to
LE(<=) Less than or Equal to
GTLT(><) Greater than and Less than
GELT(>=<) Greater than or equal to and Less than
GTLE(><=) Greater than and Less or equal to
LTGT(<>) Less than and Greater than
LEGE(<= >=) Less than or equal to and Greater than or equal to
LEGT(<= >) Less than or equal to and Greater than
LTGE(< >=) Less than and Greater than or equal to
GELE(>= =<) Greater than or equal to and Less than or equal to
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How To View and Select Connected Instruments

View and Select Connected Instruments
Related Topics

Select the Tests
Configure and Run the Tests
View Test Related Files
View the Progress of Analysis
View the Report

Viewing Connected Instruments
The Tools > Instrument Bench menu item is used to discover connected instruments required for the
tests. The application uses TekVISA to discover the connected instruments. Once the operation is done,
the Instrument Bench dialog box resumes operation and lists the instrument-related details based on the
selected search criteria.

NOTE. When the TekVISA Instrument Manager checks for connected Instruments, the Instrument Bench dialog box
does not respond.

For example, if you select LAN as the search criteria in the Instrument Bench dialog and click Refresh,
the TekVISA Instrument Manager checks for the instruments availability over LAN and the details of
the instrument are displayed under Retrieved Instruments table.

You can provide the time in the TekVISA Refresh Timeout (Seconds) field, within which if the TekVISA
Instrument Manager does not find the instruments, the TekExpress application resumes the operation.

If you choose Non-VISA resources, all the instruments supported by TekExpress but not communicating
over the VISA layer can be searched.
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Selecting Connected Instruments
You can view the instruments connected in the Configuration panel. The upper half of the panel displays
the general parameters for the tests under the selected test suite.

You can choose the instruments from the drop-down list as shown in the following figure:

NOTE. The list of instruments displayed is specific to the selected test suite. It does not show all the connected
instruments.
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How To Use Prerecorded Waveforms for Analysis

Use Prerecorded Waveforms for Analysis
From the Acquire tab, you can see unique acquisitions, acquisition parameters, acquisition status, and
prerecorded waveform files of the selected test suite. The Acquire panel is specific to a suite and gets
updated everytime the selected test suite is changed. This panel shows the acquisition details for the tests
in the currently selected suite. The tests with the common acquisition parameters are grouped together and
shown as a single acquisition.

Column name Function
Acquisition Acquisition Name
Test Name of the tests performing acquisitions. One or more test can perform same

acquisitions.
Acquire Parameters Every acquisition can have “n” number of acquire parameters. Based on the

maximum number of parameters, the number of columns and the width of the
table varies.

Status Test acquisition status of the running test passed at intervals.
Waveform File(s) Pre recorded waveform files of unique acquisitions. You can select waveform

files by selecting browse on individual cells. This allows you to select any
waveform file using the standard file open window.
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How To Use Prerecorded Waveforms for Analysis

The following Acquire source options are available:

Use Pre Recorded Waveform files: Enabling or disabling the option shows or hides the waveform
file column in the acquisition table.

Acquire Step by Step: Selecting this prompts you at the end of each acquisition before proceeding
to the next one.

Show Acquire Parameters: On enabling this option, the acquisition parameters for each unique
acquisition is displayed in the acquisition table.

More/Less: Allows you to show/hide advance panel.

TekExpress follows a certain waveform file naming conventions that helps it understand which waveform
needs to be used for different test analysis. Upon selecting "User Prerecorded Waveform Files", the first
column will display the type of waveform and second column shows the tests that will be using the given
waveform type for analysis purpose. Following guidelines will help you to appropriately specify correct
pre-recorded waveform for selected test analysis to be performed in pre-recorded fashion.

TIP. Select "Show Acquire Parameters" to verify the acquire parameters that are specified and the corresponding
waveform.

Click the following links to get details on them:

Guidelines for PHY-TSG-OOB test suite waveforms

You need to know that for a selected test differential or single ended waveform is required. If there are
multiple test combinations that requires both single ended and differential waveforms (for example, as
shown in picture below the Unit interval measurement requires differential waveform and rise-fall time
measurement requires single-ended waveforms), you need to specify all required waveforms. The naming
convention is that the waveform file name should contain one of the keywords "Diff", "Pos", "Neg" for
application to be able to identify which waveform is Differential (Diff), and which one is Positive (Pos)
signal & Negative (Neg) signal of single ended waveforms.

Guidelines for RXTX test suite waveforms

Test suites such as RXTX and SI need to have reference waveforms and waveforms with DUT. The
acquire panel allows you to specify only DUT waveforms. The reference waveforms are stored in the
following folder location:

Reference Waveforms

Location: X:\Serial ATA\Sampling Scope\TxRxScopeOperation

Naming Convention: Ref_<Acquire Type>_<Parameter1>_<Parameter2>_<Parameter3>_<Param-
eter4>_<Parameter5>_<Channel Pattern>.wfm
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How To Use Prerecorded Waveforms for Analysis

Example:

1. Ref_MFTP-TDR Common_4000_300_4e-011_1e-011_Even_CH3+CH4.wfm

2. Ref_MFTP-TDR Differential_4000_300_4e-011_1e-011_Even_CH3-CH4.wfm

3. Ref_MFTP-TDR Single Ended_4000_300_4e-011_1e-011_Even_CH3.wfm

4. Ref_TDR Common_4000_300_4e-011_1e-011_Even_CH1+CH2.wfm

5. Ref_TDR Differential_4000_300_4e-011_1e-011_Even_CH1-CH2.wfm

6. Ref_TDR Single Ended_4000_300_4e-011_1e-011_Even_CH1.wfm

DUT waveforms

DUT waveforms need to be specified in TekExpress Acquire panel as described above. The file naming
convention should be as follows:

Naming Convention: <Acquire Type> <Channel Pattern>

Acquire type and corresponding channel pattern:

Acquire Type Channel Pattern
TDR Differential CH1-CH2
TDR Single Ended CH1& CH2
TDR Common CH1+ CH2
MFTP - TDR Differential CH3-CH4
MFTP - TDR Single Ended CH3, CH4
MFTP - TDR Common CH3+CH4

Examples:

TDR Differential_CH1-CH2_EUT.wfm

TDR Single Ended_CH1.wfm

User1_TDR Common_CH1+CH2.wfm

MFTP - TDR Differential_CH3-Ch4_Session1.wfm

MFTP - TDR Single Ended_CH4_Jan31.wfm

MFTP - TDR Common_CH3+Ch4.wfm

Guidelines for SI test suite waveforms

As mentioned in the guidelines for RXTX test suite, the SI test suite also need to have reference waveforms
and waveforms with DUT. The acquire panel allows you to specify only DUT waveforms. The reference
waveforms are stored in the following folder location:

Reference Waveforms

Location: X:\Serial ATA\Sampling Scope\SIScopeOperation
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How To Use Prerecorded Waveforms for Analysis

Naming Convention:
Ref/Ref_NoFixture_<Acquire Type>_<Parameter1>_<Parameter2>_<Parameter3>_<Parameter4>_<Pa-
rameter5>_<Parameter6>_<Parameter7>_<Parameter_8>_<Channel Pattern>.wfm

Example: Reference without fixture

Ref_NoFixture_TDR Differential_Odd_4000_128_5e-010_7e-011_5.5e-011_80_20_CH1-CH2.wfm

Ref_NoFixture_TDR Single Ended_Even_4000_128_5e-010_7e-011_5.5e-011_80_20_CH1.wfm

Ref_NoFixture_TDT CrossTalk_Odd_4000_128_3e-009_CH3-CH4.wfm

Ref_NoFixture_TDT Differential_Odd_4000_128_3e-009_CH5-CH6.wfm

Ref_NoFixture_TDR Common_Even_4000_128_5e-010_7e-011_5.5e-011_80_20_CH3+CH4.wfm

Example: Reference with fixture

Ref_TDR Common_Even_4000_128_5e-010_7e-011_5.5e-011_80_20_CH1+CH2.wfm

Ref_TDR Differential_Odd_4000_128_5e-010_7e-011_5.5e-011_80_20_CH1-CH2.wfm

Ref_TDR Single Ended_Even_4000_128_5e-010_7e-011_5.5e-011_80_20_CH4.wfm

DUT waveforms

DUT waveforms need to be specified in TekExpress "Acquire" panel as described above. The file naming
convention should be as follows:

Naming Convention: <Acquire Type>_<Channel Pattern>

Acquire type and corresponding channel pattern:

Acquire Type Channel Pattern
TDR Differential CH1-CH2, CH3-CH4, CH5-CH6, CH7-CH8
TDR Single Ended CH1, CH2, CH3, CH4
TDR Common CH1+CH2, CH3+CH4
TDT Differential CH5-CH6, CH7-CH8
TDT Crosstalk CH3-CH4, CH7-CH8

Examples:

TDR Differential_CH1-CH2_EUT.wfm

TDR Single Ended_CH1.wfm

User1_TDR Common_CH1+CH2.wfm

TDT Differential_CH5-CH6_Session1.wfm

TDT Crosstalk_CH4_Jan31.wfm
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How To View the Progress of Analysis

View the Progress of Analysis
Related Topics

Select the Tests
View and Select Connected Instruments
Configure and Run the Tests
View the Report
View Test Related Files

You can view the progress of the analysis in the Analyze panel. When the analysis is complete, the result
value of each test is updated.

Analysis Table
The table contains the following:

The test name.

The status of the tests that are being run.

The Tests that are not yet started are shown with a “To be Started” status. A summarized status of the
currently running test is shown on the status.

More/Less
The Status Messages window timestamps all runtime messages and displays them. You can do the
following:
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How To View the Progress of Analysis

Display Status : Enable/Disable status messages.

Auto Scroll : The status messages are scrolled automatically.

Clear All : Clear all status messages in Status Window.

Save Status : Save all status messages in text file. Displays a standard save file window and saves the
status messages in the user specified file.

NOTE. The Status Messages window is dockable and can be resized.
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How To View the Report

View the Report
Related Topics

Select the Tests
View and Select Connected Instruments
Configure and Run the Tests
View the Progress of Analysis
View Test Related Files

After the analysis, a report is automatically generated and displayed in the report panel. The report shows
the results of the tests, including device information and pass/fail status of each test.

The Report View Area contains an HTML version of the report template. You can select any area of the
report and copy it to the clipboard to make it available to other application.

The View Scorecard option opens the report in Microsoft Excel 1.

1 You need to load Miscrosoft Excel 2002 before using the “View Scorecard” option.
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How To View Test Related Files

View Test Related Files
Related Topics

Application Directories and Usage

All the test related files for currently selected tests are always saved under My Documents\My

TekExpress\Serial ATA\Untitled Session.

When you save a session, it is saved with the session name under the path My Documents\My

TekExpress\Serial ATA\SessionName for future references.

The session that is currently running will be stored in the same path as “Untitled” until you save it.

WARNING. Sessions should not be saved in the name “Untitled” and “Backup” as they are application specific files
and will be deleted when the application exits.

A session folder can contain results for more than one DUT, and a DUT folder can contain more than one
run data folder marked by date-time stamp as folder name.

Below is an example image of data storage:
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Application Examples
RSG-RMT Suite

Testing a Drive
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Application Examples RSG-RMT Equipment Setup: Drive

RSG-RMT Equipment Setup: Drive
You need the following equipment to set up the application:

Resource Model Supported
Signal Source Tektronix AWG7102 (Option 6)
Real Time Oscilloscope Tektronix DPO/DSA 72004, DPO/DSA 71604, DPO/DSA 71254,

TDS6154C, and TDS6124C

For Gen1-only testing, the following oscilloscopes are also acceptable:
DPO/DSA 70804 or TDS6804B

RF Switch Keithley S46-6666A
Frame Error Analyzer Crescent Heart Software SATA II probe adapter
Test Fixture Crescent Heart Software Fixture TF-SATA-NE-ZP, TF-SATA-FE-ZP
DUT A SATA Drive to test

Connect the equipments as shown in the following diagram:
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Application Examples RSG-RMT Equipment Setup: Drive
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Application Examples RSG-01 - Gen1 (1.5Gb/s) Receiver Signalling Group

RSG-01 - Gen1 (1.5Gb/s) Receiver Signalling
Group

Related Topics
Equipment Setup Drive

Run RMT Receiver Margin Test1

To run an RSG test on a SATA Drive to conformance standards defined by SATA-IO Interoperability,
follow these steps:

NOTE. This test is applicable for both Drive and Host devices. The test procedure is identical for both drive and host
except for a change in the connection diagram. Refer to Figure 2 for Host connection diagram.

NOTE. All the cables must be deskewed before performing this measurement.

1. Select Drive as the device type.

2. Select RSG-RMT as the Test Suite and SATA Gen 1 as the version.

3. Enter the DUT ID in the DUT field.

4. If you want to verify the test setup before running the test(s), click Show Schematic.

5. Select RSG01-Gen1 (1.5Gb/s) Receiver Signalling Group option.

6. Click Configure to configure the test parameters. Observe that the default settings are in Compliance
mode.
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Application Examples RSG-01 - Gen1 (1.5Gb/s) Receiver Signalling Group

7. If you want to change the parameters, choose User Defined Mode. The message reports that the
changes made to a test may no longer be compliant.

8. You can configure any test to help you analyze measurement results. To refer to the Serial ATA
Interoperability Program, MOI document for information on how to configure the drive receiver tests,
click Show MOI in the Select panel.

9. Click Apply to apply the new settings for the test selected. If you want to restore the default settings,
click Restore. To close the dialog box, click Close.
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Application Examples RSG-01 - Gen1 (1.5Gb/s) Receiver Signalling Group

10.Click Run to run the selected tests.

The status of the tests is displayed in the Analyze panel.

11. After the tests run successfully, a report is generated and displayed in the Report panel.

You can save the report using File > Save Report As option.
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Application Examples RMT- Receiver Margin Test

RMT- Receiver Margin Test
Related Topics

Equipment Setup Drive
Run RSG01 Gen1 1 5Gbs Receiver Signalling
Group

To run a RMT test on a Drive device, do the following:

1. Select Drive as the Device type, select RSG-RMT test suite and SATA Gen1 as the version.

2. Select RMT - Receiver Margin Test as the test to run.

3. Click Show Schematic to view the setup diagram for the application.

NOTE. Refer to the Equipment Setup: Drive section for the setup diagram.

4. For information on how to configure the RMT test parameters, refer to RSG - RMT Method of
Implementation document by clicking Show MOI.

5. Click Configure to configure the test parameters.
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Application Examples RMT- Receiver Margin Test

6. The default settings are in User Defined Mode. Configure the Analyze parameters such as, the Start
Frequency and End Frequency. Click Apply to apply the new settings. Click Close.

7. Enter the DUT ID in the DUT field of Select panel, and click Run.

8. The progress of the Analysis is displayed in the Analyze tab.
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Application Examples RMT- Receiver Margin Test

9. The test result report is displayed in the Report panel.

.
Testing a Host
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Application Examples RSG-RMT Equipment Setup: Host

RSG-RMT Equipment Setup: Host
You need the following equipment to setup the application:

Resource Model Supported
Signal Source Tektronix AWG7102 (Option 6)
Real Time Oscilloscope Tektronix DPO/DSA 72004, DPO/DSA 71604, DPO/DSA 71254,

TDS6154C, and TDS6124C

For Gen1– only testing, the following osilloscopes are also acceptable:
DPO/DSA 70804 or TDS6804B

RF Switch Keithley S46-6666A
Frame Error Analyzer Crescent Heart Software SATA II probe adapter
Test Fixture Crescent Heart Software Fixture TF-SATA-NE-ZP, TF-SATA-FE-ZP
DUT A SATA Host to test

Connect the equipment as shown in the following diagram:
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Application Examples RSG-RMT Equipment Setup: Host
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Application Examples RSG-02 - Gen2 (3.0Gb/s) Receiver Signalling Group

RSG-02 - Gen2 (3.0Gb/s) Receiver Signalling
Group

Related Topics
Equipment Setup Host

Run RMT Receiver Margin Test

To run a RSG test on a SATA Host to conformance standards defined by SATA-IO Interoperability,
follow these steps:

NOTE. The test procedure is identical for both drive and host except for a change in the connection diagram. Refer
Figure 1 for the Drive connection diagram.

NOTE. All the cables must be deskewed before performing this measurement.

1. Select Host as the device type.

2. Select RSG-RMT test suite and SATA Gen 2 as the version.

3. Enter the DUT ID in the DUT field.

4. If you want to verify the test setup before running the test(s), click Show Schematic.

5. Select RSG-02 Gen2 (3.0Gb/s) Receiver Signalling Group option.

6. Click Configure if you want to configure the test parameters. Observe that the default settings are
in Compliance mode.
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Application Examples RSG-02 - Gen2 (3.0Gb/s) Receiver Signalling Group

7. If you want to change the parameters, choose User Defined Mode.

8. You can configure any test to help you analyze measurement results. To refer to the Serial ATA
Interoperability ProgramMOI for information on how to configure the host receiver tests, click Show
MOI in the Select panel.

9. Click Apply to apply the new settings for the selected test. If you want to restore the default settings,
click Restore. To close the dialog box, click Close.
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10.Click Run to run the selected tests. The status of the tests is displayed in the Analyze panel.
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Application Examples RSG-02 - Gen2 (3.0Gb/s) Receiver Signalling Group

11.After the tests run successfully, a report is generated and displayed in the Report panel.

You can save the report using File > Save Report As menu option.
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Application Examples RMT- Receiver Margin Test

RMT- Receiver Margin Test
Related Topics

Equipment Setup Host
Run RSG02 Gen2 3 0Gbs Receiver Signalling
Group

To run an RMT test on a Host device, do the following:

1. Select Host as the Device type.

2. Select RSG-RMT test suite and SATA Gen2 as the version.

3. Select RMT - Receiver Margin Test as the test to run.

4. Click Show Schematic to view the setup diagram for the application.

NOTE. Refer to Equipment Setup: Host section, for the setup diagram.

5. For information on how to configure the RMT test parameters, refer to RSG - RMT Method of
Implementation document by clicking Show MOI.

6. Click Configure to configure the test parameters.

7. The default settings are in User Defined Mode. Configure the Analyze parameters such as, the Start
Frequency and End Frequency.

8. Click Apply to apply the new settings. Click Close.
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Application Examples RMT- Receiver Margin Test

9. Enter the DUT ID in the DUT field. Click Run. The progress of the analysis is displayed in the
Analysis tab.

TekExpress™ Serial ATA Automated Compliance Solutions 57



Application Examples RMT- Receiver Margin Test

10.The test results are displayed in the Report panel.

.
PHY-TSG-OOB Suite

Testing a Drive
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Application Examples PHY-TSG-OOB Equipment Setup: Drive

PHY-TSG-OOB Equipment Setup: Drive
You need the following equipment to set up the application:

Resource Model Supported
Signal Source Tektronix AWG7102 (Option 6)
Real Time Oscilloscope Tektronix DPO/DSA 72004, DPO/DSA 71604,

DPO/DSA 71254, TDS6154C, and TDS6124C

For Gen1-only testing, the following oscilloscopes are
also acceptable: DPO/DSA 70804 or TDS6804B

RF Switch Keithley S46-6666A (optional)
Test Fixture Crescent Heart Software Test Fixture TF-SATA-NE-ZP
DUT A SATA Drive to test

Connect the equipments as shown in the following diagram:
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Application Examples PHY01 - Unit Interval-Gen1 Test

PHY01 - Unit Interval-Gen1 Test
To verify that the Unit Interval of the SATA Drive transmitter is within the conformance limit, follow
these steps:

NOTE. The test procedure is identical for both drive and host except for a change in the connection diagram. Refer to
Figure 3 for the Host connection diagram.

NOTE. All the cables must be deskewed before performing this measurement.

1. Select Drive as the device type.

2. Select the PHY-TSG-OOB as the Test Suite and SATA Gen1 as the version.

3. Select PHY01 - Unit Interval-Gen1 option.

4. Enter the DUT ID in the DUT field.

5. If you want to verify the test setup before running the test(s), click Show Schematic.

6. Click Configure to configure the test parameters. Observe that the default settings are in Compliance
mode.
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Application Examples PHY01 - Unit Interval-Gen1 Test

NOTE. The parameters that are not grayed are editable. To change the instrument related values, select from the
drop-down list for each of the parameters.

7. You can configure any test to help you analyze measurement results. To refer to the Serial ATA
Interoperability Program MOI document for information on how to configure the drive transmitter
tests, click Show MOI in the Select panel.

8. Click Apply to apply the new settings for the selected test. If you want to restore the default settings,
click Restore. To close the dialog box, click Close.

9. Click Run to run the selected tests.

10.The Acquire panel shows the status of the waveform acquisition.
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Application Examples PHY01 - Unit Interval-Gen1 Test

11.The status of the tests is displayed in the Analyze panel.
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Application Examples PHY01 - Unit Interval-Gen1 Test

12. After the tests complete, a report is generated and displayed in the Report panel.

You can save the report using File > Save Report As option.
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Application Examples TSG02 - Rise-Fall Time-Gen1 Test without RF Switch

TSG02 - Rise-Fall Time-Gen1 Test without RF
Switch

To verify that the Rise/Fall time of the SATA Drive transmitter is within the conformance limits, follow
these steps:

NOTE. Refer to schematic for connection diagram without the RF Switch.

NOTE. All the cables must be deskewed before performing this measurement.

1. Select Drive as the device type.

2. Select PHY-TSG-OOB as the Test Suite and SATA Gen1 as the version.

3. Enter the DUT ID in the DUT field.

4. Select theTSG02 - Rise-Fall Time-Gen1 option.

5. If you want to verify the test setup before running the test(s), click Show Schematic.

6. Click Configure to configure the test parameters. Observe that the default settings are in Compliance
mode.
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Application Examples TSG02 - Rise-Fall Time-Gen1 Test without RF Switch

NOTE. The parameters that are not grayed are editable. To change the instrument related values, select from the
drop-down list for each of the parameters.

7. You can configure any test to help you analyze measurement results. To refer to the Serial ATA
Interoperability Program MOI document for information on how to configure the drive transmitter
tests, click Show MOI in the Select panel.

8. To run the test without using RF Switch, choose the Do not use option from the drop-down list for
the RF switch parameter in the Configure panel.

9. Click Apply to apply the new settings for the selected test and click Close.

10.Click Run to run the selected tests.

11.The Acquire panel shows the status of the waveform acquisition.
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Application Examples TSG02 - Rise-Fall Time-Gen1 Test without RF Switch

12.The status of the tests is displayed in the Analyze panel.
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Application Examples TSG02 - Rise-Fall Time-Gen1 Test without RF Switch

13. After the tests complete, a report is generated and displayed in the Report panel.
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Application Examples TSG02 - Rise-Fall Time-Gen1 Test without RF Switch
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Application Examples OOB01 - OOB Signal Detection Threshold-Gen1 Test

OOB01 - OOB Signal Detection Threshold-
Gen1 Test

To verify that the OOB Signal Detection Threshold of the SATA Drive receiver is within the conformance
limits, follow these steps:

NOTE. All the cables must be deskewed before performing this measurement.

1. Select Drive as the device type.

2. Select PHY-TSG-OOB as the Test Suite and SATA Gen1 as the version.

3. Enter the DUT ID in the DUT field.

4. Select the OOB01 - OOB Signal Detection Threshold - Gen1 option.

5. If you want to verify the test setup before running the test(s), click Show Schematic.

6. Click Configure to configure the test parameters. Observe that the default settings are in Compliance
mode.

7. If you want to change the parameters, choose User Defined Mode. The message reports that the
changes made to a test may no longer be compliant.
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Application Examples OOB01 - OOB Signal Detection Threshold-Gen1 Test

8. You can configure any test to help you analyze measurement results. To refer to the Serial ATA
Interoperability ProgramMOI document for information on how to configure the drive receiver tests,
click Show MOI in the Select panel.

9. Click Apply to apply the new settings for the test selected. If you want to restore the default settings,
click Restore. To close the dialog box, click Close.

10.Click Run to run the selected tests.

11.The application automatically switches to the Acquire panel showing the waveform acquisition status.
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Application Examples OOB01 - OOB Signal Detection Threshold-Gen1 Test

12.The status of the tests is displayed in the Analyze panel.
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Application Examples OOB01 - OOB Signal Detection Threshold-Gen1 Test

13. After the tests complete, a report is generated and displayed in the Report panel.

.
Testing a Host
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Application Examples PHY-TSG-OOB Equipment Setup:Host

PHY-TSG-OOB Equipment Setup:Host
You need the following equipment to set up the application:

Resource Model Supported
Signal Source Tektronix AWG7102 (Option 6)
Real Time Oscilloscope Tektronix DPO/DSA 72004, DPO/DSA 71604, DPO/DSA 71254, TDS6154C,

and TDS6124C

For Gen1-only testing, the following oscilloscopes are also acceptable:
DPO/DSA 70804 or TDS6804B

RF Switch Keithley S46-6666A
Test Fixture Crescent Heart Software test fixture, TF-SATA-NE-ZP
DUT A SATA Host to test

Connect the equipments as shown in the following diagram:
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TSG03 - Differential Skew-Gen 2 Test
To verify that the differential skew of the SATA Host transmitter is within the conformance limits, follow
these steps:

NOTE. The test procedure is identical for both drive and host except for a change in the connection diagram. Refer to
Figure 4 for the Drive connection diagram.

NOTE. All the cables must be deskewed before performing this measurement.

1. Select Host as the device type.

2. Select PHY-TSG-OOB as the Test Suite and SATA Gen2 as the version.

3. Enter the DUT ID in the DUT field.

4. Select the TSG03 - Differential Skew-Gen2 option.

5. If you want to verify the test setup before running the test(s), click Show Schematic.

6. Click Configure to configure the test parameters. Observe that the default settings are in Compliance
mode.
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NOTE. The parameters that are not grayed are editable. To change the instrument related values, select from the
drop-down list for each of the parameters.

7. You can configure any test to help you analyze measurement results. To refer to the Serial ATA
Interoperability Program MOI document for information on how to configure the drive transmitter
tests, click Show MOI in the Select panel.

8. Click Apply to apply the new settings for the test selected. If you want to restore the default settings,
click Restore. To close the dialog box, click Close.

9. Click Run to run the selected tests.
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10.The Acquire panel shows the status of the waveform acquisition.

11.The status of the tests is displayed in the Analyze panel.
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12. After the tests complete, a report is generated and displayed in the Report panel.
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OOB06 - COMWAKE Gap Detection Windows
Test

To verify that the COMWAKE Gap Detection Windows of the SATA Host receiver is within the
conformance limits, follow these steps:

NOTE. All the cables must be deskewed before performing this measurement.

1. Select Host as the device type.

2. Select PHY-TSG-OOB as the Test Suite and SATA Gen1 as the version.

3. Enter the DUT ID in the DUT field.

4. Select the OOB06 - COMWAKE Gap Detection Windows option.

5. If you want to verify the test setup before running the test(s), click Show Schematic.

6. Click Configure to configure the test parameters. Observe that the default settings are in Compliance
mode.

7. If you want to change the parameters, choose User Defined Mode. The message reports that the
changes made to a test may no longer be compliant.
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8. You can configure any test to help you analyze measurement results. To refer to the Serial ATA
Interoperability ProgramMOI document for information on how to configure the drive receiver tests,
click Show MOI in the Select panel.

9. Click Apply to apply the new settings for the selected test. If you want to restore the default settings,
click Restore. To close the dialog box, click Close.

10.Click Run to run the selected tests.

11.The application automatically switches to the Acquire panel showing the waveform acquisition status.

TekExpress™ Serial ATA Automated Compliance Solutions 79



Application Examples OOB06 - COMWAKE Gap Detection Windows Test

12.The status of the tests is displayed in the Analyze panel.
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13. After the tests complete, a report is generated and displayed in the Report panel.

.
Rx-Tx Suite

Testing a Drive
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Rx-Tx Equipment Setup: Drive
Resource Model Supported
Signal Source Tektronix AWG7102 (Option 6)
Sampling Oscilloscope Tektronix CSA/TDS/DSA 8200 with two 80E04 modules
RF Switch Keithley S46-6666A
Test Fixture Crescent Heart Software Fixture TF-SATA-NE-ZP
SMA Cables Five pair of matched SMA Cables – 179-4944-00 or equivalent

One SMA cable to connect to trigger input

One SMA barrel adapter
Attenuators Two 6 dB attenuators
DUT A SATA Drive to test

Connect the equipments as shown in the following diagram:
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Rx01 - Pair Differential Impedance test
To verify that the Pair Differential Impedance of the SATA Drive receiver is within the conformance
limits, follow these steps:

NOTE. This test is applicable for both Drive and Host devices. The test procedure is identical for both drive and host
except for a change in the connection diagram. Refer to Figure 5 for Host connection diagrams.

1. Select Drive as the device type.

2. Select RX-TX as the Test Suite and SATA Gen 1 as the version.

3. Enter the DUT ID in the DUT field.

4. If you want to verify the test setup before running the test(s), click Show Schematic.

5. Select the Rx-01 – Pair Differential Impedance option.

6. Click Configure to configure the test parameters. Observe that the default settings are in Compliance
mode.

NOTE. The parameters that are not grayed are editable. To change the instrument related values, select from the
drop-down list for each of the parameters.
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7. You can configure any test to help you analyze measurement results. To refer to the Serial ATA
Interoperability Program document for information on how to configure the drive receiver tests,
click Show MOI in the Select panel.

8. Click Apply to apply the new settings for the test selected. If you want to restore the default settings,
click Restore. To close the dialog box, click Close.
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9. Click Run to run the selected tests.

10.The Acquire panel shows the waveform acquisition status.

11.The status of the tests is displayed in the Analyze panel.
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12. After the tests complete, a report is generated and displayed in the Report panel.
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Tx02 - Single-Ended Impedance test
To verify that the Single-Ended Impedance of the SATA Drive transmitter is within the conformance
limits, follow these steps:

1. Select Drive as the device type.

2. Select RX-TX as the Test Suite and SATA Gen 1 as the version.

3. Enter the DUT ID in the DUT field.

4. If you want to verify the test setup before running the test(s), click Show Schematic.

5. Select the Tx-02 Single-Ended Impedance option.

6. Click Configure to configure the test parameters. Observe that the default settings are in Compliance
mode.

NOTE. The parameters that are not grayed are editable. To change the instrument related values, select from the
drop-down list for each of the parameters.

7. You can configure any test to help you analyze measurement results. To refer to the Serial ATA
Interoperability Program MOI document for information on how to configure the drive transmitter
tests, click Show MOI in the Select panel.
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8. Click Apply to apply the new settings for the selected test. If you want to restore the default settings,
click Restore. To close the dialog box, click Close.

9. Click Run to run the selected tests.
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10.The application automatically switches to the Acquire panel. The waveform acquisition status is
displayed in this panel.

11.The status of the tests is displayed in the Analyze panel.

TekExpress™ Serial ATA Automated Compliance Solutions 89



Application Examples Tx02 - Single-Ended Impedance test

12. After the tests complete, a report is generated and displayed in the Report panel.

You can save the report using File > Save Report As option.
.

Testing a Host
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Rx-Tx Equipment Setup: Host
Resource Model Supported
Signal Source Tektronix AWG7102 (Option 6)
Sampling Oscilloscope Tektronix CSA/DSA/TDS 8200 with two 80E04 modules
RF Switch Keithley S46-6666A
Test Fixture Crescent Heart Software Fixture TF-SATA-NE-ZP
SMA Cables Five pair of matched SMA Cables – 179-4944-00 or equivalent

One SMA cable to connect to trigger input

One SMA barrel adapter
Attenuators Two 6 dB attenuators
DUT A SATA Host to test

Connect the equipments as shown in the following diagram:
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Rx03 - Differential Mode Return Loss
To verify that the Differential Mode Return Loss of the SATA Host receiver is within the conformance
limits, follow these steps:

NOTE. This test is applicable for both Drive and Host devices. The test procedure is identical for both drive and host
except for a change in the connection diagram. Refer to Figure 6 for Drive connection diagrams.

1. Select Host as the device type.

2. Select RX-TX as the Test Suite and SATA Gen 2 as the version.

3. Enter the DUT ID in the DUT field.

4. If you want to verify the test setup before running the test(s), click Show Schematic.

5. Select Rx03 - Differential Mode Return Loss option.

6. Click Configure to configure the test parameters. Observe that the default settings are in Compliance
mode.

7. If you want to change the parameters, choose User Defined Mode. The message reports that the
changes made to a test may no longer be compliant.

92 TekExpress™ Serial ATA Automated Compliance Solutions



Application Examples Rx03 - Differential Mode Return Loss

8. You can configure any test to help you analyze measurement results. To refer to the Serial ATA
Interoperability ProgramMOI document for information on how to configure the host receiver tests,
click Show MOI in the Select panel.

9. Click Apply to apply the new settings for the test selected. If you want to restore the default settings,
click Restore. To close the dialog box, click Close.

10.Click Run to run the selected tests.

11.The application automatically switches to the Acquire panel. The status of the waveform acquisition is
displayed in this panel.
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12.The status of the tests is displayed in the Analyze panel.
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13. After the tests complete, a report is generated and displayed in the Report panel.

You can save the report using File > Save Report As option.
.
SI Cable test
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SI Equipment Setup
Resource Model Supported
Sampling Oscilloscope Tektronix CSA/DSA/TDS 8200 with four 80E04 modules
Test Fixture Two Crescent Heart Software Fixture TF-SATA-FE-ZP
SMA Cables Four pairs of matched SMA Cables 179-4944-01 or equivalent

Two SMA barrel adapters
DUT A SATA Cable to test

Connect the equipment as shown in the following diagram:
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SI-02 - Cable Absolute Differential Impedance
test on a SATA Cable

To run an SI test on a SATA Cable to conformance standards defined by SATA-IO Interoperability, follow
these steps:

NOTE. This test is applicable only for SATA cables.

1. Select Cable as the device type.

2. Select SI as the Test Suite.

NOTE. There will be no test suite version for a SI test.

3. Enter the DUT ID in the DUT field.

4. If you want to verify the test setup before running the test(s), click Show Schematic.

5. Select a SI-02 – Cable Absolute Differential Impedance option.

6. Click Configure to configure the test parameters. Observe that the default settings are in Compliance
mode.
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7. If you want to change the parameters, choose User Defined Mode. The message reports that the
changes made to a test may no longer be compliant.

8. You can configure any test to help you analyze measurement results. To refer to the Serial ATA
Interoperability ProgramMOI document for information on how to configure the cable tests, click
Show MOI in the Select panel.

9. Click Apply to apply the new settings for the test selected. If you want to restore the default settings,
click Restore. To close the dialog box, click Close.

10.Click Run to run the selected tests.
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11.The application automatically switches to the Acquire panel. This shows the status of the waveform
acquisition.

12.On completion of the acquisition, the application switches to the Analyze panel. This panel shows the
status of the analysis.
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13. After the tests run successfully, a report is generated and displayed in the Report panel.

You can save the report using File > Save Report As option.
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Deskew Operation
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Deskewing Real Time Oscilloscopes
Related Topics

Manual Deskew Procedure for Sampling
Oscilloscopes

The following procedure is used for deskewing direct input SMA channels on a real time oscilloscope.

NOTE. This deskew method is applicable for RSG-RMT and PHY-TSG-OOB test suites.

1. Run Signal Path Compensation (SPC) on the oscilloscope.

2. Connect a SMA Power Splitter (preferred) or SMA 50 ohm coax tee to the Fast Edge output of the
oscilloscope.

3. Connect SMA cables from each of the two channels to be deskewed to the power splitter (or SMA coax
tee). It is best to use matched cables when making high speed serial measurements. It is important to
use the same cables that will be used for subsequent measurements.

4. Select Default Setup, and then select Autoset on the oscilloscope front panel.

5. Set the oscilloscope for 70% to 90% full screen amplitude on both channels. Center both traces so
that they overlap.

6. Make sure that volts/div, position, and offset are identical for the two channels being deskewed.

7. Set the time/div to approximately 100 ps/div or less, with sample rate at 1 ps/pt. These settings are not
critical, but should be close.

8. Set the horizontal acquistion mode to average, which provides a more stable display.

9. Select Deskew from the Vertical menu.

10.Verify that the reference channel (typically CH1 or CH2) is set to 0 ps deskew.

11. In the deskew control window, select the channel to deskew (typically CH3 or CH4). Adjust the deskew
to overlay the rising edge as best as possible.

NOTE. Typical values are in the 10’s of ps or less with cables connected directly from Fast Edge to SMA inputs. If
you are using a switch box (for example, Keithley), deskew the complete path from where the test fixture connects,
through the switch, and into the oscilloscope. Deskew values in these cases may be as much as 30 ps or more.

There are sometimes significant differences in the skew between two TCA-SMA adapters. If you find
that a system requires a very large correction, it might be better to find a pair of TCA-SMA adapters
that match each other better.

102 TekExpress™ Serial ATA Automated Compliance Solutions



Deskew Operation Manual Deskew Procedure for Sampling Oscilloscopes

Manual Deskew Procedure for Sampling
Oscilloscopes

Mixed Mode TDR Channel Alignment with Independent TDR Source
This deskew procedure uses an independent acquisition source and assumes availability of two TDR
sampling modules (80E04, 80E08, or 80E10). You can also deskew with one TDR (80E04, 80E08, or
80E10), and one dual sampling module (80E03 or 80E09). It aligns both samplers and TDR steps allowing
you to measure mixed mode S-parameters. The procedure starts with the alignment of the samplers and
concludes with alignment of the acquisition channels.

The following equipment is required:

One sampling oscilloscope mainframe (TDS8000, TDS/CSA/DSA8200).

Two TDR sampling modules (80E04, 80E08, or 80E10).

Four matched SMA cables.

One SMA barrel (female-to-female) adaptor. Click here to view the picture.

Equipment required to perform mixed mode deskew procedure. The wrist strap is important for
ESD protection and a calibrated torque wrench is recommended to protect the connectors and to
get good repeatability.

Click the links below to get details on them.
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Align the acquisition channels to the ends of the cables.

The purpose of this step is to set the samplers on each channel so that an input into the open end of each
cable arrives at the sample gate at precisely the same time. This step compensates for cable and sampler
differences. CH1 through CH3 are aligned using CH4 as an independent TDR source. Then, CH4 is
aligned with respect to CH3 using CH1 as the independent source. The following deskew procedure is
to be performed in rho mode.

The “rho” can be selected from the TDR menu of the Setups dialog. Follow the below steps to
get to the rho mode:

1. Select the Setups menu from the Oscilloscope main menu.

2. Click the TDR tab.

3. Select ρ option from the drop-down list.

1. Connect SMA cables to the sampling modules of the oscilloscope. For the best results, ensure that
the SMA cables used in the measurements have approximately the same quality and length (matched
within 20 ps).

2. Connect channel 1 and channel 4 with SMA barrel, activate TDR step on channel 4 and acquire using
channel. Click here to see the figure.
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CH1 is connected to CH4 with an SMA barrel. The TDR step is generated on CH4 and acquired
using CH1.

3. Adjust the horizontal position and scale to get the rising edge on screen with good resolution (20
ps/div). Record length should have a maximum of 4000 points.

4. Save channel one (CH1) waveform as a reference trace. CH2 and CH3 will be aligned with respect to it.

5. Connect CH2 to the CH4 using SMA barrel, and display CH2 on the screen.

6. Turn on the delay measurement to measure the time difference between the rising edge on the reference
trace and the rising edge of CH2 as shown here.
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Delay measurements between the reference (R1) acquired from the CH1 and the CH2. It has to
be the minimum for the best deskew value.

7. Adjust the channel deskew value in the Vertical menu of the Setups dialog box until a delay value
within 1 ps is achieved.

8. Repeat step 5 through step 7 for the CH3.

9. Once, the acquisition of CH1 through CH3 is aligned, use the same method to align CH4. Generate
a new reference by using the step of CH1 and acquiring it on CH3. Connect CH3 to CH1 with the
SMA barrel.

10.Repeat step 5 through step 7 for the CH4 using acquired reference from CH3.

Now, all four acquisition channels have been deskewed within 1 ps.

Match TDR step generators.

The purpose of this step is to adjust the TDR pulses so that they arrive at the ends of the cables at
precisely the same time. The deskew has to be performed separately for odd and even TDR steps when
80E04 modules are used. This section describes only odd mode TDR step deskew. The following deskew
procedure has to be performed in rho mode:

1. Disconnect the SMA barrel and turn on TDR pulses of the appropriate polarity for each channel (CH1
and CH2). Use the differential TDR preset selection to activate odd mode.

2. Adjust the horizontal position and scale so that the pulses are visible on the screen as they arrive at the
ends of the cables. (Use the Average mode and vectored display, and set the time scale to 20 ps/div).

3. Turn on the delay measurement to measure the time difference between the two pulse edges.

4. Adjust the Step Deskew in the TDR menu to minimize the time difference between the CH1 and CH2
pulses. You might want to use the Fine button to reduce the increment of deskew as shown here.
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Differential TDR step deskew. The channels CH1 and CH2 are aligned within ~300 fs.

5. Repeat step 1 through step 4 for CH3 and CH4, and save the instrument setup.

6. Repeat step 1 through step 5 in even mode if desired.

The instrument should now be set up to accurately make differential or common mode TDR measurements.
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Deskew parameters for RxTx

RxTx Default Deskew Parameters Settings
The default settings of deskew parameters in the Configure panel are found to be optimal for deskew with
short length cable and test setup without RF switch. The default values are as follows:

Horizontal Scale (ps): 50

Horizontal Scale - Deskew (ps): 1000

Horizontal Scale - wide window (ps): 3000

RxTx Deskew Parameters Settings with Long Cable and/or RF Switch
If you are using long cable and/or an using RF switch in RxTx setup, then following values are
recommended. You can change these values by selecting the Configure panel from the RxTx suite and the
parameters that are located in the upper half of the configure table.

Horizontal Scale (ps): 500

Horizontal Scale - Deskew (ps): 3000

Horizontal Scale - wide window (ps): 10000
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Overriding Acquire Parameters

About Overriding Acquire Parameters
This section is applicable for the test suites that require a real time ocilloscope (for example, test suites like
PHY-TSG-OOB or RSG-RMT). The TekExpress application supports various oscilloscope models for
SATA compliance testing and not all the oscilloscope models can support the same acquire parameters
(combination of record length, horizontal scale and resolution). For such test suites, TekExpress allows you
to either “Automatically” apply correct acquire parameters settings or manually specify them. (This option
is available in “Configure” panel of corresponding test suite with option name “Set oscilloscope scale,
resolution and sampling rate”). When “Automatically” is selected, the application ignores the acquire
parameters you specified. If you need to specify your own acquire parameters, then you must specify the
name “Set oscilloscope scale, resolution and sampling rate” option to “Manually” in “Configure” panel of
corresponding test suite.

Acquire parameters with “Automatically” option
This option will be applicable for the following oscilloscope models only. If any other oscilloscope
model is found, the application will automatically use the parameters specified by you while executing
the test sequence.

Supported TDS models: TDS6154C, TDS6124C, and TDS6804B

Supported DPO/DSA models: DPO/DSA70804, DPO/DSA71254, DPO/DSA71604, and
DPO/DSA72004.

For supported oscilloscope models, the following acquire parameters would be applied automatically
during test sequence execution depending on the type of acquisition.

TDS6154C, TDS6124C, TDS6804B
DPO/DSA70804, DPO/DSA71254,
DPO/DSA71604, DPO/DSA72004

Acquisition Type
Scale
(μs/div)

Resolution
(ps/pt)

Sampling
rate
(Gs/s)

Scale
(μs/div)

Resolution
(ps/pt)

Sampling
rate

BISTL validation
for RSG/RMT

10 25 10 20

BISTL validation
for PHY/TSG

4 25 4 20

Initial OOB
validation

2 100 10 2 80 12.5

HFTP * 40 25 40 40
HFTP-Gen 1 10 50 10 40
HFTP-Gen 2 4 25 4 20
LBP-Gen 1 10 50 10 40
LBP-Gen 2 4 25 4 20
LFTP-Gen 1 10 50 10 40
LFTP-Gen 2 4 25 4 20
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TDS6154C, TDS6124C, TDS6804B
DPO/DSA70804, DPO/DSA71254,
DPO/DSA71604, DPO/DSA72004

Acquisition Type
Scale
(μs/div)

Resolution
(ps/pt)

Sampling
rate
(Gs/s)

Scale
(μs/div)

Resolution
(ps/pt)

Sampling
rate

MFTP-Gen 1 10 50 10 40
MFTP-Gen 2 4 25 4 20
COMINIT and
COMWAKE

10 50 20 10 40 25

COMINIT INSPEC
LL

200 800 1.25 200 800 1.25

COMINIT INSPEC
UL

200 800 1.25 200 800 1.25

COMINIT INSPEC
UL

200 800 1.25 200 800 1.25

COMINIT
OUTOFSPEC LL

200 800 1.25 200 800 1.25

COMINIT
OUTOFSPEC UL

200 800 1.25 200 800 1.25

CO-
MINIT/COMRE-
SET/COMWAKE-No
response

200 800 1.25 200 800 1.25

CO-
MINIT/COMRE-
SET/COMWAKE-
Response

200 800 1.25 200 800 1.25

COMWAKE
INSPEC LL

200 800 1.25 200 800 1.25

COMWAKE
OUTOFSPEC LL

200 800 1.25 200 800 1.25

COMWAKE
OUTOFSPEC UL

200 800 1.25 200 800 1.25

COMRESET 4 50 20 4 40 25
COMWAKE 10 50 20 10 40 25

* Long record length for Gen1 SSC and Gen2 SSC

Acquire Parameters with “Manually” Option
It is important that you carefully specify the correct combination of horizontal scale and resolution
depending on the oscilloscope model. If an incorrect combination of horizontal scale and resolution is
specified then the test execution sequence is terminated, displaying incorrect parameter set status message.

An example of status message is as shown:

10/3/2007 10:29 AM::Writing command-HORIZONTAL:RECO 2500000
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10/3/2007 10:29 AM::Set record length to-2000000

The following procedure describes how to manually identify a working combination of horizontal scale,
resolution and record length for a given oscilloscope:

1. Open the Talker Listener utility of the TekVISA on the oscilloscope.

2. Apply default settings on the oscilloscope by clicking Default setup on the oscilloscope panel front
panel.

3. Use the oscilloscope front panel to disable CH1and enable CH2 and CH4.

4. In the Talker Listener utility, enter HORI:RECO <record length> (for example, HORI:RECO
2000000) and clickWrite.

5. Verify that the oscilloscope has applied the record length that you specified in step 4. If yes, continue
with step 6 else repeat steps 2 through 4 with another record length.

6. In the Talker Listener utility, enter HORI:SCALE <horizontal scale> (for example, HORI:SCALE
10E-06) and clickWrite.

7. Verify that the oscilloscope has applied the horizontal scale that you specified in step 6 and also verify
that the record length set in step 4 is not changed. If this condition is met, then you have identified a
working combination of Acquire parameters. If this condition is not met, then repeat steps 2 through 6
with another combination of Acquire parameters.

The above step will help identify the correct combination of horizontal scale and record length. If you
wish to find combination of horizontal scale and resolution follow the same procedure as above and find
the resolution using the following mathematical expression.

Resolution = Record Length / (10 * horizontal scale)
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Pattern Generation Utility

Using the Pattern Generation Utility to Test
Receivers

Related Topics
Calibration Procedure

The Pattern Generation is a utility that generates a controlled jittered waveform for performing the RSG
(Receiver Signal Gain) and RMT (Receiver Margin Testing) testing for the DUT receiver. This utility uses
a direct synthesis approach where required amounts of jitter components are added to the frame composite.
These patterns are injected to DUT using the Arbitrary Waveform Generator 7000 series with option 6,
Test fixture and matched pair cables.

Use the Calibration process (as outlined in the MOI) to set the calibrated amplitude level, Random Jitter,
Periodic Jitter (Optimal amplitude value of) jittered frequency (which is tuned to meet the nominal Total
Jitter specified) are the inputs for the pattern generation utility.

It’s recommended to do the calibration process for each pattern generation of interest.

For the RMT tests, there is a need to test the DUT over a range of frequencies. The calibration has to be
carried out at these frequencies for exact results.

Inputs to the Pattern Generation Utility
The Pattern Generation Utility is an Executable and requires you to input the following parameters (in this
order). You need to provide below inputs and there are not default values.

1. The path of the Frame composite pattern IW4Gen1R10FCP2AnewLBP.txt for Gen1 and
IW4Gen2R8FCP2AnewLBP for Gen2. This pattern is very specific for the utility and has known
characteristics such as 10 characters per line.

2. The speed of the DUT such as usage model Gen1/Gen2.

3. Calibrated voltage swing for the utility. This is usually calculated using the 6 db attenuators at the end of
the match cables. You can refer the amplitude calibration process to measure calibrated amplitude level.

4. The calibrated Random Jitter (Rj). You can refer to the calibration procedure for more details on how to
calculate the Rj value for this setup. Rj has to specified in ps RMS.

5. Periodic Jitter (Pj) component as frequency in Hz. You can specify the frequency value between 0
to 300 MHz as ‘Start’e6 and ‘Stop’e6. The start should be less than the stop otherwise the utility
shows an error.

6. The Pj increment is in steps of 1 MHz (step given as “xxe6”) and the higher range is 300 MHz.

7. The Total jitter (Tj specified in Unit Interval (UI)) range is 0 to 1.2 UI. You have to specify the start
and stop separately as ‘Start’ and ‘Stop’ without the ‘UI’ unit. The start should be less than the stop
otherwise the utility will show an error.

8. The Tj values. These values increase in the following steps as per the Serial ATA standard. The
predefined steps are 0.01, 0.02, 0.03, 0.05 and 0.1.

9. The Amplitude Periodic jitter. You have to make sure that the amplitude periodic jitter used in the
utility to generate pattern of interest (for example 10 MHz 0.45 UI) has to result in nominal Tj value
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0.45 UI. This is done by means of trial and error by recording the Tj at the output of the JIT3 Analysis –
Advanced software. Please refer to the MOI calibration procedure for more details.

Output from the Pattern Generation Utility
The generated jittered waveform is available in the Frame composite pattern file path with file name as
<Jitter Frequency>-MHz-<TJ>UI.wfm. <Example Pj from 100 MHz to 105 MHz and Tj= 0.45 UI:
The sample file name output format is 100-MHz-0.45UI.wfm. The five AWG patterns are generated
from 100 MHz to 105 MHz.

Batch file usage
To get familiar with the usage of Serial ATA Pattern Generation Utility, an example Example_01.bat file
is provided in the location C:\SataPatternGenerationUtility after the installation.

The following are the steps to use the batch file example:

1. Double-click the Example_01.bat file.

2. The batch file gets launched and you can observe the input parameters on DOS command prompt that
is taken by the utility.

3. The jittered waveforms are generated and saved at location C:\SataPatternGenerationUtility.

114 TekExpress™ Serial ATA Automated Compliance Solutions



Pattern Generation Utility Calibration Procedure

Calibration Procedure
Related Topics

Using Pattern Generation Utility to Test Receivers

To generate jittered waveforms for RSG test, the complete calibration procedure has to be followed.
Whereas, in case of generating jittered patterns for RMT test, only Random jitter calibration is required.
Calibration can be carried out using the JIT3 Analysis - Advanced software.

Click any of the following jitter-related measurements to see its definition:
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Random Jitter Calibration

A reference Gen1 and Gen2 MFTP waveform with zero jitter (MFTP-Rj-Cal.wfm) is provided at
c:\SataPatternGenerationUtility\Gen1MFTP folder to verify the calibration of Random jitter
(Rj). Before verifying the Rj calibration, perform an SPC calibration on the Tektronix oscilloscope hosting
the Advanced JIT3 Analysis software and perform a D/A channel calibration on the Arbitrary Waveform
Generator (AWG) to compensate for the instrument’s environmental conditions.

Rj is specified to be 0.18 UI PtP @ 7 Sigma or 4.285 ps RMS for Gen2 signaling rates and correspondingly
8.57 ps for Gen1 signaling rates.

NOTE. The Rj found in the Tektronix AWG MFTP pattern has been digitally synthesized and is a truncated Gaussian
distribution with the 4.7 Sigma crest factor.

As illustrated in the red circled area of the preceding figure, ensure that the averaged RJ is nominally
reading 4.285 ps RMS ± 4% allowable variation 4.11 ps < Nominal Value < 4.45 ps. Analyze 16E6
contiguous points per measurement, and 3 runs will typically converge on an averaged RJ close to 4.285
ps. For Gen1 rates the nominal variation of Rj would be within 8.22 < Nominal Tj Value < 8.9. Jitter
magnitudes in excess of these values should result in recalibration of the AWG.

If the measured value in JIT3 results does not match with nominal Rj value 4.285 ps ±4% then random
jitter component has to be varied as the input to the utility.

Perform this iteration until Rj value is close enough to nominal value specified.
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Tj Calibration

Run the Pattern Generation utility using the IW4Gen1R10FCP2AnewLBP.txt for Gen1 and
IW4Gen2R8FCP2AnewLBP.txt for Gen2 text patterns available at c:\SataPatternGenerationU-
tility\. With calibrated random jitter value and optimal value of the Amplitude of jittered frequency,
generate a XX-MHz -0.45UI.wfm waveform. Analyze this waveform using JIT3 Advanced software.

Observe the averaged Total @ BER (Pk-Pk) Jitter value after three acquisitions. Adjust the amplitude of
jittered frequency value input so as to get the nominal value of Tj. The nominal accuracy of a calibrated
system will provide 0.45 UI Tj conformance within 4% of nominal error. The observed jitter for Gen2
signaling Tj should nominally be 149.9 ps of Tj ± 4% allowable variation. 144 ps < Nominal Tj Value <
155.8 ps. Jitter magnitudes in excess of these values should result in recalibration of the AWG.

For Gen1 rates, the nominal variation of a nominal value of Tj would be within 288 < Nominal Tj
Value < 312 ps.

If the measured value in the JIT3 results does not match with nominal Tj value 144 ps < Nominal Tj Value
< 155.8 ps then vary the amplitude of the periodic jitter component as the input to the utility.

Perform this iteration till Tj value is close enough to the nominal specified.

Amplitude Calibration

Signal amplitude conformance requires that Gen1 and Gen2 signaling not exceed 600 mV or 750 mV ptp
and be within 5% of a target minimum amplitude of 325 mV and 275 mV respectively. Fine adjustment
may be performed by adjusting the Vertical amplitude setting on the AWG’s CH1 output. The minimum
amplitude measurements are performed on both 212141 (negative pulse) and 413 (positive pulse) RL
patterns.

Refer to the SATA specifications (Serial ATA Revision 2.5 27-October-2005) on LBP based amplitude
measurements.

The minimum amplitude over a 1 UI epoch is the two consecutive bits at the string of a four or more
consecutive bits, which is not a representative LBP pattern but is the minimum value in Framed Composite
(Pre-ECN18) pattern.

A 0.45 UI to 0.55 UI Histogram is setup on the two lone bits of interest from which the difference of the
mean values is computed to obtain the lone pulse amplitudes.
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Transition Time Validation

Make sure the Rise and Fall time is in the nominal range of < 100 ps. This can be verified using the JIT3
application with same setup files used for Jitter calibration/validation. Rise and Fall time measurements
allow you to validate that the transition rate does not exceed 100 ps 20/80.

After the completion of calibration process, Calibrated Voltage swing required in the jittered waveform,
Calibrated Random Jitter, Optimal value for Amplitude of jittered frequency are available and can be used
for generating waveforms for RSG and RMT tests.
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User Configuration for TekExpress SATA

Setting User Option for SATA DUT Power
Cycle Method

TekExpress SATA offers three methods that you can choose from for power cycle operation of SATA
DUTs during the test sequence. You also have an option to fully customize the DUT power cycle operation
automation sequence. Following are the options for defining the SATA DUT power cycle method:

Manual Power Cycle

Power Cycle using AWG DC output to control AT/ATX power supply (default setting)

User specified TestStand sequence

For more details on how to use and configure these options, refer to the DUT-PowerCycle.txt file located
under ICP folder of TekExpress installed folder location.
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# =====================

# Note: Read and use this file very carefully.

# Lines with # prefix are considered comments.

# This file defines the way SATA DUT Power Cycle operation is performed during test automation.

# The first line in this TXT file that does not have # charater defines the SATA DUT Power Cycle
operation.

# This line should contain one of following keywords (without quotes).

# "Manual", "AWG", "User Defined GPIB", "User Defined TestStand Steps".

# If anything other than above valid keyword is found then Manual method overrides.

# "Manual" : This assumes manual operation of power cycle.

# "AWG" : This assumes AT/ATX power supply is controlled through DC output of AWG.

# Connect Channel-1 of DC output to pin #14 (and pin #15 to GND) in case of 20 pin Molex
connector of AT/ATX power supply.

# Connect Channel-1 of DC output to pin #16 (and pin #17 to GND) in case of 24 pin Molex
connector of AT/ATX power supply.

# "User Defined GPIB" : This assumes a user defined sets of GPIB commands are defined.

# in lines following the valid keyword "User Defined GPIB". (This feature is not active).

# "User Defined TestStand Steps" : This assumes the power cycle steps are defined in
"UserDefinedTurnOFF" & "UserDefinedTurnON" sequence of "ICP_DUT-PowerSupply.seq" file.

# ====================

AWG

Delete this line and start GPIB commands from here onwards, each line assumed to be one command,
you need to take care of complete sequencing from VI_open till VI_close.
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TekExpress Programmatic Interface

About Programmatic Interface
Related Topics

Server and Client Proxy Objects

The Programmatic interface allows you to seamlessly integrate the TekExpress test automation application
with the high-level automation layer. This also allows you to control the state of TekExpress application
running on a local or a remote PC. Following operations can be performed using the programmatic
interface exposed by TekExpress:

Query DUT ID

Set DUT ID

SaveSession

RecallSession

Run the TekExpress execution

Stop the TekExpress execution

Query execution status

Transfer result files

For simplifying the descriptions, the following terminologies are used in this section:

TekExpress Client: A High level automation application that communicates with TekExpress using
TekExpress Programmatic Interface.

TekExpress Server: The TekExpress application when being controlled by TekExpress Client.

TekExpress leverages .Net Marshalling to enable the Programmatic Interface for TekExpress Client.
TekExpress provides a client library for TekExpress clients to use the programmatic interface. The
TekExpress client library is inherited from .Net MarshalByRef class to provide the proxy object for the
clients. The TekExpress client library maintains a reference to the TekExpress Server and this reference
allows the client to control the server state.
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Click on the following links to get details on them:

What does one need to have to develop TekExpress Client ?

While developing TekExpress Client one needs to use the TekExpressClient.dll. The client can be a VB
.Net, C# .Net, TestStand or web application. The examples for interfaces in each of these applications
are in Samples folder.

References required
TekExpressClient.dll has internal reference to IIdlglib.dll and IRemoteInterface.dll IIdlglib.dll has a
reference to TekDotNetLib.dll. IRemoteInterface.dll provides the interfaces required to perform the remote
automations. It is an interface that forms the communication line between the server and the client.
IIdlglib.dll provides the methods to generate and direct the secondary dialog messages at the client-end.

NOTE. The end-user client application does not need any reference to above mentioned DLL files. It is essential
to have these DLLs (IRemoteInterface.dll, IIdlglib.dll and TekDotNetLib.dll) in same folder location as that of
TekExpressClient.dll.

What steps does a Client need to follow ?

The following are the steps that a client needs to follow to use the TekExpressClient.dll to programmatically
control the server:

A client UI has to be developed to access the interfaces exposed through the server. This client needs to
load TekExpressClient.dll to access the interfaces. Once the TekExpressClient.dll is loaded, the
client UI can call the specific functions to run the operations requested by the client. Once the client is up
and running, it has to do the following to run a remote operation:

1. The client needs to provide the IP address of the PC at which the server is running in order to connect to
the server.

2. The client needs to lock the server application to avoid conflict with any other Client that may try to
control the server simultaneously. “Lock” would also disable all user controls on server so that server
state cannot be changed by manual operation.

3. If any other client tries to access a server which is locked, it will get a notification that the server
is locked by another client.

4. When the client has connected to and locked the server, the client can access any of the programmatic
controls to run the remote automations.

5. Once the client operations are completed, the server needs to be “unlocked” by the Client.
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Server and Client Proxy Objects

Remote Proxy Object
The server exposes a remote object to let the remote client access and perform the server side operations
remotely. The proxy object is instantiated and exposed at the server-end through marshalling.

The following is an example:

RemotingConfiguration.RegisterWellKnownServiceType (typeof (TekExpressRe-

moteInterface), “TekExpress Remote interface”, WellKnownObjectMode.Singleton);

This object lets the remote client access the interfaces exposed at the server side. The client gets the
reference to this object when the client gets connected to the server.

For example,

//Get a reference to the remote object

remoteObject = (IRemoteInterface)Activator.GetObject(typeof(IRemoteInterface),

URL.ToString());
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Client Proxy Object
Client exposes a proxy object to receive certain information.

For example,

//Register the client proxy object

WellKnownServiceTypeEntry[] e = RemotingConfiguration.GetRegisteredWell-

KnownServiceTypes();

clientInterface = new ClientInterface();

RemotingConfiguration.RegisterWellKnownServiceType(typeof(ClientInterface),

“Remote Client Interface”, WellKnownObjectMode.Singleton);

//Expose the client proxy object through marshalling

RemotingServices.Marshal(clientInterface, "Remote Client Inteface");

The client proxy object is used for the following:

1. To get the secondary dialog messages from the server.

2. To get the file transfer commands from the server while transferring the report.

Click here to see examples.

clientObject.clientIntf.DisplayDialog(caption, msg,iconType, btnType);

clientObject.clientIntf.TransferBytes(buffer, read, fileLength);
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To know more on the topics below, click on the links.

Secondary Dialog Message Handling

The secondary dialog messages from the Secondary Dialog library are redirected to the client-end when a
client is peforming the automations at the remote end.

In the secondary dialog library, the assembly that is calling for the dialog box to be displayed is checked
and if a remote connection is detected, the messages are directed to the remote end.

File Transfer Events

When the client requests the transfer of the report, the server reads the report and transfers the file by
calling the file transfer methods at the client-end.
Programmatic Interface APIs
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Connect()

Connect(string ipAddress, out string clientID)
This method connects the client to the server. The client provides the ip address of the server to connect to
the server. The server provides a unique clientId when the client is connected to it.

Parameters

Name Type Direction Description
ipAdress string IN The ip address of the server to which the client is

trying to connect to. This is required to establish
the connection between the server and the client.

clientid String OUT Identifier of the client that is connected to the
server.
clientId = unique number + ipaddress of the
client. For example, 1065–192.157.98.70

Return Value
Value that suggests the status if the connection was established or an error occured. The return value is an
object that can be a boolean value, returning true or a string, returning the error message.

Example
try {

IPAddress[] hostIPAddr = Dns.GetHostAddresses(Dns.GetHostName());

// Connect to the remoter Server

remoteObject.Connect(hostIPAddress, clientInterface, out clientID);

return true;

}

catch (Exception error)

{

return error;

}

Comments
The server has to be active and running for the client to connect to the server. Any number of clients can
be connected to the server at a time. Each client will get a unique id.
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Disconnect()

Disconnect(string id)
This method disconnects the client from the server it is connected to.

Parameters

Name Type Direction Description
id String IN Identifier of the client that is performing

the remote function.

Return Value
Integer value that suggests the status of the operation after it has been performed.

1 – Success

–1 – Failure

Example
try

{

string returnVal = UnlockServer (clientId);

remoteObject.Disconnect (clientId);

return 1;

}

Comments
When the client is disconnected, it is unlocked from the server and then disconnected. The id is reused.
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LockSession()

LockSession(string id)
This method locks the server. The client has to call this method before running any of the remote
automations. The server can be locked by only one client.

Parameters

Name Type Direction Description
id String IN Identifier of the client that is performing

the remote function.

Return Value
String value that suggests the status of the operation after it has been performed.

Example
if (locked)

return “Session has already been locked!”;

returnVal = remoteObject.LockSession(clientId);

if ((OP_STATUS)returnVal == OP_STATUS.SUCCESS)

{

locked = true;

return “Session Locked...”;

}

Comments
When the client tries to lock a server that is locked by another client, the client gets a notification that the
server is already locked and it has to wait until the server is unlocked.

If the client locks the server and is idle for a certain amount of time then the server is unlocked
automatically from that client.
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UnlockSession()

UnlockSession(string id)
This method unlocks the server from the client. The client id of the client to be unlocked has to be provided.

Parameters

Name Type Direction Description
id string IN Identifier of the client that is performing

the remote funtion.

Return Value
String that suggests the status of the operation after it has been performed.

Example
returnVal = remoteObject.UnlockSession(clientId);

if ((OP_STATUS)returnVal == OP_STATUS.SUCCESS)

{

locked = false;

return “Session Un-Locked...”;

}

Comments
When the client is disconnected, it is automatically unlocked.
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SetTimeOut()

SetTimeOut (string id, string time)

Parameters

Name Type Direction Description
id string IN Identifier of the client that

is performing the remote
function.

time string IN The time in seconds which
refers to the timeout period.

Return Value
String that suggests the status of the operation after it has been performed.

Example
if (ClientId == ClientID)

{

if (locked == true)

{

tempTime = Int32.Parse(time);

}

if (tempTime < 0)

return “Enter a valid Timeout Period”;

else

{

timeout = tempTime;

return “Timeout Period Changed”;

}

}
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Comments
The time parameter gives the timeout period, that is the time the client is allowed to be locked and idle.
After the timeout period if the client is still idle, it gets unlocked.

The time parameter should be a positive integer. Else, the client is prompted to provide a valid timeout
period.

GetTimeOut()

GetTimeOut (string id)

Parameters

Name Type Direction Description
id string IN Identifier of the client that

is performing the remote
function.

Return Value
String that suggests the status of the operation after it has been performed.

Example
if (ClientId == ClientID)

{

ResetTimer();

return timeOut.ToString();

}

Comments
The timeout period is a positive integer.
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GetDutId()

GetDutId(string id, string dutId)
This method gives the DUT id of the current set-up.

Parameters

Name Type Direction Description
id string IN Identifier of the client that is performing

the remote funtion.
dutId string OUT The DUT id of the set-up.

Return Value
String that gives the timeout period (in seconds) of the client.

Example
returnVal = remoteObject.GetDutId(clientId, out id);

if ((OP_STATUS)returnVal == OP_STATUS.SUCCESS)

{

return id;

}

else

return CommandFailed(returnVal);

Comments
The dutId is an OUT parameter whose value is set after the server processes the request.
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ChangeDutId()

ChangeDutId(string id, string dutName)
This method changes the DUT id of the set-up. The client has to provide a valid DUT id.

Parameters

Name Type Direction Description
id string IN Identifier of the client that is performing

the remote funtion.
dutName string IN The new DUT id of the set-up.

Return Value
String that suggests the status of the operation after it has been performed.

Example
If (dut Id.Length <=0 && locked == true)

return “Enter a valid DUT-ID”;

returnVal = remoteObject.ChangeDutId(clientId, dutId);

if ((OP_STATUS)returnVal == OP_STATUS.SUCCESS)

return “DUT Id Changed...”;

else

return CommandFailed(returnVal);

Comments
If the dutName parameter is null, the client is prompted to provide a valid DUT id.
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SaveSession()

SaveSession(string id, string name)
Saves the current session. The name of the session is provided by the client.

Parameters

Name Type Direction Description
id string IN Identifier of the client that is performing

the remote funtion.
name string IN The name of the session being saved.

Return Value
String that suggests the status of the operation after it has been performed.

Example
returnVal = remoteObject.SaveSession(clientId,sessionName);

if ((OP_STATUS)returnVal == OP_STATUS.SUCCESS)

return “Session Saved...”;

else

return CommandFailed(returnVal);

Comments
The name parameter cannot be empty. If it is empty, the client is prompted to provide a valid name.

Once the session is saved under ‘name’ you cannot use this method to save the session in a different name.
Instead SaveSessionAs can be used.
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SaveSessionAs()

SaveSessionAs(string id, string name)
Saves the current session in a different name every time this method is called. The name of the session is
provided by the client.

Parameters

Name Type Direction Description
id string IN Identifier of the client that is performing

the remote funtion.
name string IN The name of the session being saved.

Return Value
String that suggests the status of the operation after it has been performed.

Example
returnVal = remoteObject.SaveSessionAs(clientId,sessionName);

if ((OP_STATUS)returnVal == OP_STATUS.SUCCESS)

return “Session Saved...”;

else

return CommandFailed(returnVal);

Comments
The same session is saved under different names using this method. The name parameter cannot be empty.
If it is empty, the client is prompted to provide a valid name.
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RecallSession()

RecallSession(string id, string name)
Recalls a saved session. The name of the session is provided by the client.

Parameters

Name Type Direction Description
id string IN Identifier of the client that is performing

the remote funtion.
name string IN The name of the session being recalled.

Return Value
String that suggests the status of the operation after it has been performed.

Example
returnVal = remoteObject.RecallSession(clientId,sessionName);

if ((OP_STATUS)returnVal == OP_STATUS.SUCCESS)

return “Session Recalled...”;

else

return CommandFailed(returnVal);

Comments
The name parameter cannot be empty. If it is empty, the client is prompted to provide a valid name.
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Run()

Run(string id)
Runs the setup. Once the server is set up and is configured, it can be run remotely using this function.

Parameters

Name Type Direction Description
id string IN Identifier of the client that is performing

the remote funtion.

Return Value
String that suggests the status of the operation after it has been performed.

Example
returnVal = remoteObject.Run(clientId);

if ((OP_STATUS)returnVal == OP_STATUS.SUCCESS)

return “Run started...”;

else

return CommandFailed(returnVal);

Comments
When the run is performed the status of the run is updated periodically using a timer.
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Stop()

Stop(string id)
Stops the run operation.

Parameters

Name Type Direction Description
id string IN Identifier of the client that is performing

the remote funtion.

Return Value
String that suggests the status of the operation after it has been performed.

Example
returnVal = remoteObject.Stop(clientId);

if ((OP_STATUS)returnVal == OP_STATUS.SUCCESS)

return “Stopped...”;

else

return CommandFailed(returnVal);

Comments
When the session is stopped the client is prompted to stop the session and is stopped at the consent.
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QueryStatus()

QueryStatus(string id, out string[] status)
This method gives the status of the run as messages. The status messages are generated once the run
is started.

Parameters

Name Type Direction Description
id string IN Identifier of the client that is performing

the remote funtion.
status string array OUT The list of status messages generated

during run.

Return Value
String that suggests the status of the operation after it has been performed.

Example
returnVal = remoteObject.QueryStatus(clientId, out statusMessages);

if ((OP_STATUS)returnVal == OP_STATUS.SUCCESS)

return “Status updated...”;

else

return CommandFailed(returnVal);

Comments
The status messages are updated periodically after the run begins. The status is an out parameter which is
set when the server processes the request.
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TransferReport()

TransferReport(string id, string filePath)
This method transfers the report generated after the run. The report contains the summary of the run. The
client has to provide the location where the report is to be saved at the client-end.

Parameters

Name Type Direction Description
id string IN Identifier of the client that is performing

the remote funtion.
filePath string IN The location where the report has to be

saved in the client.

Return Value
String that suggests the status of the operation after it has been performed.

Example
returnVal = remoteObject.TransferReport(clientId);

if ((OP_STATUS)returnVal == OP_STATUS.SUCCESS)

return “Transferred...”;

else

return CommandFailed(returnVal);

Comments
If the client does not provide the location to save the report, the report is saved at C:\ProgramFiles.
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CheckSessionSaved()

CheckSessionSaved(string id, out bool saved)
This function is called when a check is to be made to know if the current session is saved.

Parameters

Name Type Direction Description
id string IN Identifier of the client that is performing

the remote funtion.
saved bool OUT Boolean which represents if the current

session is saved.

Return Value
Void

Example
if (clientId == ClientID)

{

returnVal = remoteObject.IsSessionSaved(id,out saved);

}

Comments
The saved parameter gives the boolean value suggesting if the current session is saved or not. This is used
as a check in SaveSession() and SaveSessionAs() Functions.
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ErrorCodes
The return value of the remote automations at the server-end is OP_STATUS which is changed to a string
value depending on its code and returned to the client.

The values of OP_STATUS are as follows:

Value Code Description
FAIL −1 The operation failed.
SUCCESS 1 The operation succeded.
NOTFOUND 2 Server not found
LOCKED 3 The server is locked by another client, so operation cannot

be performed.
UNLOCK 4 The server is not locked. Lock the server before performing

the operation.
NULL 0 Nothing
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TekExpress Programmatic Interface Example

Example
The following is an example for NI TestStand Client available in the path, C:\Program
Files\Tektronix\TekExpress\Examples\Programmatic Interface\TestStand
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TekExpress Programmatic Interface Example
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Troubleshooting Instrument Connectivity

Troubleshooting

Instrument Connectivity
Related Topics

User Interface
TestStand Runtime Engine Installation

If the instrument(s) are displayed in TekVISA Instrument Manager but not in the TekExpress Instrument
Bench, check the following:

Only those instruments that respond to *idn? and *opt? queries successfully, are displayed in
Instrument Bench.

Ensure that VXI-11 Server is running on the instruments.

If Instrument initialization fails during test sequence execution, do the following:

It is observed that GPIB communication with instrument over Tek-VISA layer is not initialized if in
TekVISA Instrument manager the search criteria is turned-off even if valid instrument is connected in the
network. It is necessary to turn ON the respective search criteria by opening the TekVISA Instrument
manager.

User Interface
Related Topics

Instrument Connectivity
TestStand Runtime Engine Installation

The Acquire tab is disabled.

For a selected test suite, the test is performed on a live acquisition. If test(s) such as PHY-TSG-OOB can
be performed on pre-acquired waveforms, this tab is active.
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Troubleshooting TestStand Run time Engine Installation

TestStand Run time Engine Installation
Related Topics

Instrument Connectivity
User Interface

Managing multiple versions of TestStand installed on the system.

TekExpress installs TestStand version 3.5 runtime engine. If you have versions other than 3.5, while
working with TekExpress, ensure that the version shipped with TekExpress is active. You can do so by
clicking Start > Programs > National Instruments > TestStand 3.5 > TestStand Version Selector.
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Troubleshooting Test Limit is Single Sided

Test Limit is Single Sided
Related Topics

Instrument Connectivity
TestStand Runtime Engine Installation
User Interface

The test limit is single sided but report shows second value and value is shown as 0.

If the test limits are single sided for limits such as GT(>) Greater than, LT(<) Less than; then the second
value is by default 0 and is ignored by test automation script. In such cases, while analyzing the report the
second value should be ignored.
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Troubleshooting Report shows as NAN

Report shows as NAN
Related Topics

Instrument Connectivity
TestStand Runtime Engine Installation
User Interface
Test Limit is Single Sided

Some of the result values in the report are shown as NAN.

NAN is IEEE definition for “Not a Number”. The possible causes are as follows:

The captured pattern (HFTP, MFTP, LFTP, LBP waveform files) for the analysis does not contain
a valid pattern.

The NAN value is commonly seen in TSG measurements when LFTP pattern is required for analysis
but the captured pattern is not true LFTP.

The NAN value can be seen in the final reports if a test algorithm does not successfully evaluate a
result due to one or more reasons listed above.

For trouble shooting, you can analyze the captured waveform using pattern analyzer utility which is
available in TekExpress\ACP folder. The patternAnalyzer.exe need to be run from MS DOS prompt
and takes the following command line argument:

patternAnalyzer.exe <InterfaceSpeed> <WaveformFile> <OutputTXTfile> where,

InterfaceSpeed should be specified as either Gen1 or Gen2.

Waveform file is complete waveform file path.

OutputTXTfile is output text file path.

For example, patternAnalyzer.exe “Gen2” “X:\Serial ATA\SavedSes-

sion\DUT001\20080206_185914\BISTL_HFTP_G2_Drive_DW2_Diff.wfm” “X:\results.txt”.
Open the contents of X:\results.txt to see the results.
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Reference Shortcut Keys

Reference

Shortcut Keys
The following table lists the short cut keys to access the application:

Table 10: Keyboard shortcut keys
Menu Shortcut keys
File Alt + F
New Session Ctrl + N
Open Session... Ctrl + O
Save Session... Ctrl + S
Save Report As... Alt + F + A
Print Preview Report Alt + F + V
Print Report... Ctrl + P
Recent Sessions Alt + F + R
Exit Ctrl + X
View Alt + V
Log File Ctrl + L
Tools Alt + T
Instrument Bench... Ctrl + I
Debug-Deskew Utility Alt + T + D
Help Alt + H
TekExpress Help (F1) Alt + H + H
About... Alt + H + A
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Reference Error Codes for TekExpress

Error Codes for TekExpress
The following table lists the error codes for the application. Most of the errors require that you restart
the system.

Table 11: Error codes and Description
Error Code Description
<10000 TestStand generated error.
10001 - 11000 – Data Manager related errors
10001 Insufficient Data. The Record could not be inserted. The following

fields are empty or have insufficient data.
10002 Could not retrieve the record. The specified index is not valid.
11001 - 14000 – ICP related errors
11001 Operation mode is not set as specified.
11002 SetUp file Error: Specified SetUp file is not set.
11003 Operation state is not set as specified.
11004 Specified waveform is not loaded into channel memory.
11005 Specified channel is not enabled.
11006 Interleave State could not be set to off.
12001 Operation State is not set to required value.
12002 Display state is not set to required value.
12003 Horizontal Scale is not set to required value.
12004 Vertical scale is not set to required value.
12005 Vertical Position is not set to required value.
12006 Deskew is not set to specified value.
12007 Out of Range Error-RunTime Error Message.
14001 - 18000 – SCP related errors
14001 Timeout Error: Application could not be activated.
14002 JIT3 Application is already running.
14003 Cannot activate JIT3 application. Someother application is running

on Scope.
14004 Error recalling the specified setup.
14005 Error setting the specified Sequencer State.
14006 Error in closing the Application.
14007 Error loading the default setup.
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Index
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J
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K
Key Features, 15

L
Log File, 20

M
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folder, 12
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Menus

File, 19
Help, 24
Tools, 21
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Run
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Save
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Server, 125
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Shortcut Keys, 153
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Report, 39
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TroubleShooting
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